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safety information
These warnings and precautions are included in order to prevent injury to you and others, as well as preventing any 
potential damage to your machine. Be sure to read and understand all of these instructions before using the machine.
Use common sense for operating any electrical appliance and whenever using your machine. Also, follow all warnings and 
instructions marked on the machine and in the accompanying literature. After reading this section, keep it in a safe place 
for future reference.

IMPORTANT SAFETY SYMBOLS

This section explains the meanings of all icons and signs in the user's guide. These safety symbols are in order, according to the degree of 
danger.

Explanation of all icons and signs used in the user’s guide:

Warning Hazards or unsafe practices that may result in severe personal injury or death.

Caution Hazards or unsafe practices that may result in minor personal injury or property damage.

Do not attempt.

Do not disassemble.

Do not touch.

Unplug the power cord from the wall socket.

Make sure the machine is grounded to prevent electric shock.

Call the service center for help.

Follow directions explicitly.

OPERATING ENVIRONMENT

 Warning

Do not use if the power cord is damaged or if the 
electrical outlet is not grounded.

This could result in electric shock or fire. 

Do not bend, or place heavy objects on the power 
cord. 

Stepping on or allowing the power cord to be 
crushed by a heavy object could result in electric 
shock or fire. 

Do not place anything on top of the machine (water, 
small metal or heavy objects, candles, lit cigarettes, 
etc.).

This could result in electric shock or fire. 

Do not remove the plug by pulling on the cord; do not 
handle the plug with wet hands. 

This could result in electric shock or fire. 
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 Caution

During an electrical storm or for a period of 
non-operation, remove the power plug from the 
electrical outlet. 

This could result in electric shock or fire. 

If the plug does not easily enter the electrical outlet, do not 
attempt to force it in. 

Call an electrician to change the electrical outlet, or this 
could result in electric shock.

Be careful, the paper output area is hot. 
Burns could occur. 

Do not allow pets to chew on the AC power, telephone or PC 
interface cords.

This could result in electric shock or fire. 

If the machine has been dropped, or if the cabinet appears 
damaged, unplug the machine from all interface connections 
and request assistance from qualified service personnel.

Otherwise, this could result in electric shock or fire.

If the machine does not operate properly after these 
instructions have been followed, unplug the machine from all 
interface connections and request assistance from qualified 
service personnel.

Otherwise, this could result in electric shock or fire.

If the machine exhibits a sudden and distinct change in 
performance, unplug the machine from all interface 
connections and request assistance from qualified service 
personnel.

Otherwise, this could result in electric shock or fire.

OPERATING METHOD

 Caution

Do not forcefully pull the paper out during printing. 
It can cause damage to the machine.

When printing large quantities, the bottom part of the 
paper output area may get hot. Do not allow children 
to touch. 

Children may be burned.

Be careful not to put your hand between the machine 
and paper tray.

You may get injured.

When removing jammed paper, do not use tweezers 
or sharp metal objects. 

It can cause damage to the machine.

Do not block or push objects into the ventilation opening.
This could result in elevated component temperatures which 

can cause damage or fire.

Do not allow too many papers to stack up in the paper output 
tray.

It could cause damage to the machine. 

Use care to avoid paper cuts when replacing paper or removing 
jammed paper. 

You may get hurt.

This machine's power interception device is the power cord. 
To switch off the power supply, remove the power cord from 

the electrical outlet. 

If the machine gets overheated, it releases smoke, 
makes strange noises, or generates an odd odor, 
immediately turn off the power switch and unplug the 
machine.

This could result in electric shock or fire. 
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INSTALLATION / MOVING

 Warning

Do not place the machine in an area with dust, 
humidity or water leaks. 

This could result in electric shock or fire. 

 Caution

When moving the machine, turn the power off and 
disconnect all cords; then lift the machine with at 
least two people.

The machine could fall, causing human injury or 
machine damage.

Do not put a cover over the machine or place it in an airtight 
location, such as a closet.

If the machine is not well-ventilated, this could result in fire.

Do not place the machine on an unstable surface.
The machine could fall, causing human injury or machine 

damage.

Make sure you plug the power cord into a grounded electrical 
outlet.

Otherwise, this could result in electric shock or fire.

The machine should be connected to 
the power level which is specified on the label.

If you are unsure and want to check the power level you are 
using, contact the electrical utility company.

Do not overload wall outlets and extension cords.
This can diminish performance, and could result in electric 

shock or fire.

Use only No.26 AWGa

a.  AWG: American Wire Gauge

 or larger, telephone line cord, if 
necessary.

Otherwise, it can cause damage to the machine.

Use the power cord supplied with your machine for safe 
operation. If you are using a cord which is longer than 2 meters 
(79”) with a 140V machine, then the gauge should be 16 AWG 
or larger.

 Otherwise, it can cause damage to the machine, and could 
result in electric shock or fire.

MAINTENANCE / CHECKING

 Caution

Unplug this product from the wall outlet before 
cleaning the inside of the machine. Do not clean the 
machine with benzene, paint thinner or alcohol; do 
not spray water directly into the machine. 

This could result in electric shock or fire. 

Keep cleaning supplies away from children. 
Children may get hurt.

When you are working inside the machine replacing 
supplies or cleaning the inside, do not operate the 
machine.

You may get injured.

Do not disassemble, repair or rebuild the machine by 
yourself. 

It can cause damage to the machine. Call a 
certified technician when the machine needs repair.
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SUPPLY USAGE

 Caution

Do not disassemble the toner cartridge.
Toner dust can be dangerous to humans.

When storing supplies such as toner cartridges, keep 
them away from children.

Toner dust can be dangerous to humans.

Do not burn any of the supplies such as toner 
cartridge or fuser unit.

It can cause an explosion or fire.

Using recycled supplies, such as toner, can cause damage to 
the machine.

In case of damage due to the use of recycled supplies, a 
service fee will be charged.

When changing the toner cartridge or removing jammed paper, 
be careful not to let toner dust touch your body or clothes.

Toner dust can be dangerous to humans.

Keep the power cable and the contact surface of the plug clean 
from dust or water.

This could result in electric shock or fire. 

To clean and operate the machine, strictly follow the user's 
guide provided with the machine.

Otherwise, it can cause damage to the machine.

Do not remove any covers or guards that are fastened with 
screws.

The machine should only be repaired by Samsung service 
technician.
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regulatory information
The machine is certified with several regulatory statements.

LASER SAFETY STATEMENT

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, chapter 1 Subchapter J for Class I(1) laser products, and 
elsewhere is certified as a Class I laser product conforming to the requirements of IEC 825.
Class I laser products are not considered to be hazardous. The laser system and printer are designed so there is never any human access to 
laser radiation above a Class I level during normal operation, user maintenance or prescribed service condition.

WARNING
Never operate or service the printer with the protective cover removed from Laser/Scanner assembly. The reflected beam, although invisible, 
can damage your eyes.
When using this product, these basic safety precautions should always be followed to reduce risk of fire, electric shock, and injury to persons:

OZONE SAFETY

During normal operation, this machine produces ozone. The ozone produced does not present a hazard to the operator. However, it is 
advisable that the machine be operated in a well ventilated area.
If you need additional information about ozone, request your nearest Samsung dealer.

POWER SAVE

This printer contains advanced energy conservation technology that reduces power consumption when it is not in active use.
When the printer does not receive data for an extended period of time, power consumption is automatically lowered. 
ENERGY STAR and the ENERGY STAR mark are registered U.S. marks. 
For more information on the ENERGY STAR program see http://www.energystar.gov.
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RECYCLING

Recycle or dispose of the packaging material for this product in an environmentally responsible manner.

CHINA ONLY

CORRECT DISPOSAL OF THIS PRODUCT (WASTE ELECTRICAL & ELECTRONIC EQUIPMENT)

(Applicable in the European Union and other European countries with separate collection systems)
This marking on the product, accessories or literature indicates that the product and its electronic accessories (e.g. charger, headset, USB 
cable) should not be disposed of with other household waste at the end of their working life. To prevent possible harm to the environment or 
human health from uncontrolled waste disposal, please separate these items from other types of waste and recycle them responsibly to 
promote the sustainable reuse of material resources. 
Household users should contact either the retailer where they purchased this product, or their local government office, for details of where and 
how they can take these items for environmentally safe recycling.
Business users should contact their supplier and check the terms and conditions of the purchase contract. This product and its electronic
accessories should not be mixed with other commercial wastes for disposal.

RADIO FREQUENCY EMISSIONS

FCC Information to the User
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
• This device may not cause harmful interference, and
• This device must accept any interference received, including interference that may cause undesired operation.
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses 
and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to 
try to correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or experienced radio TV technician for help.

Change or modifications not expressly approved by the manufacturer responsible for compliance could void the user's authority to
operate the equipment.
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Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in the interference-causing 
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and Science Canada.
Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe B prescrites dans la 
norme sur le matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par l’Industrie et Sciences Canada.

RUSSIA ONLY

AE95AE95

REPLACING THE FITTED PLUG (FOR UK ONLY)

Important
The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug and has a 13 amp fuse. When you change or examine the 
fuse, you must re-fit the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost the fuse cover, do not use the plug until 
you have another fuse cover. 
The 13 amp plug is the most widely used type in the UK and should be suitable. However, some buildings (mainly old ones) do not have normal 
13 amp plug sockets. You need to buy a suitable plug adaptor. Do not remove the moulded plug.

If you cut off the moulded plug, get rid of it straight away.

You cannot rewire the plug and you may receive an electric shock if you plug it into a socket.

Important warning: 
You must earth this machine.
The wires in the mains lead have the following color code:
• Green and Yellow: Earth
• Blue: Neutral
• Brown: Live

If the wires in the mains lead do not match the colors marked in your plug, do the following:
You must connect the green and yellow wire to the pin marked by the letter “E” or by the safety ‘Earth symbol’ or colored green and yellow or 
green.
You must connect the blue wire to the pin which is marked with the letter “N” or colored black.
You must connect the brown wire to the pin which is marked with the letter “L” or colored red.
You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.
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DECLARATION OF CONFORMITY (EUROPEAN COUNTRIES)

Approvals and Certifications
The CE marking applied to this product symbolizes Samsung Electronics Co., Ltd. Declaration of Conformity with the following applicable 
93/68/EEC Directives of the European Union as of the dates indicated:

Hereby, Samsung Electronics declare that this product is in compliance with the essential requirements and other relevant provisions of:
CLP-620 Series/CLP-670 Series:  Low Voltage Directive (2006/95/EC) and EMC Directive (2004/108/EC).
The declaration of conformity may be consulted at www.samsung.com/printer, go to Support > Download center and enter your printer (MFP) 
name to browse the EuDoC. 
January 1, 1995: Council Directive 2006/95/EC Approximation of the laws of the member states related to low voltage equipment.
January 1, 1996: Council Directive 2004/108/EC (92/31/EEC), approximation of the laws of the Member States related to electromagnetic 
compatibility.
March 9, 1999: Council Directive 1999/5/EC on radio equipment and telecommunications terminal equipment and the mutual recognition of 
their conformity. A full declaration, defining the relevant Directives and referenced standards can be obtained from your Samsung Electronics 
Co., Ltd. representative.

EC Certification
Certification to 1999/5/EC Radio Equipment & Telecommunications Terminal Equipment Directive (FAX)
This Samsung product has been self-certified by Samsung for pan-European single terminal connection to the analogue public switched 
telephone network (PSTN) in accordance with Directive 1999/5/EC. The product has been designed to work with the national PSTNs and 
compatible PBXs of the European countries:
In the event of problems, you should contact the Euro QA Lab of Samsung Electronics Co., Ltd. in the first instance.
The product has been tested against TBR21. To assist in the use and application of terminal equipment which complies with this standard, the 
European Telecommunication Standards Institute (ETSI) has issued an advisory document (EG 201 121) which contains notes and additional 
requirements to ensure network compatibility of TBR21 terminals. The product has been designed against, and is fully compliant with, all of the 
relevant advisory notes contained in this document.

OPENSSL LICENSE

Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgment: “This product includes 

software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/.)"
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without 

prior written permission. For written permission, please contact openssl-core@openssl.org.
5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written 

permission of the OpenSSL Project.
6. Redistributions of any form whatsoever must retain the following acknowledgment: “This product includes software developed by the 

OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/.)"
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software written by Tim 
Hudson (tjh@cryptsoft.com).
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ORIGINAL SSLEAY LICENSE

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.
This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to conform with 
Netscapes SSL.
This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The following conditions apply to 
all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this 
distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com). Copyright remains Eric Young's, 
and as such any Copyright notices in the code are not to be removed. If this package is used in a product, Eric Young should be given 
attribution as the author of the parts of the library used. This can be in the form of a textual message at program startup or in documentation 
(online or textual) provided with the package.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgement: “This product includes 

cryptographic software written by Eric Young (eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library 
being used are not cryptographic related:-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an
acknowledgement: “This product includes software written by Tim Hudson (tjh@cryptsoft.com)."

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  
IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
The licence and distribution terms for any publically available version or derivative of this code cannot be changed. i.e. this code cannot simply 
be copied and put under another distribution licence [including the GNU Public Licence.
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CHINA ONLY



About this user’s guide_ 13

about this user’s guide
This user’s guide provides information about how to use the machine. Both novice and professional users can refer to this 
as a guide for installing and using the machine.

• Read the safety information before using the machine.
• If you have a problem using the machine, refer to the troubleshooting chapter (See "Troubleshooting" on page 65).
• Terms used in this user’s guide are explained in the glossary chapter (See "Glossary" on page 100).
• All illustrations in this user’s guide may differ from your machine depending on its options or models.
• The procedures in this user’s guide are mainly based on Windows XP.

CONVENTION
Some terms in this guide are used interchangeably, as below:
• Document is synonymous with original.
• Paper is synonymous with media, or print media.
• Machine refers to printer or MFP.
The following table offers the conventions of this guide:

CONVENTION DESCRIPTION EXAMPLE

Bold For texts on the display or button names on the machine. Start

Note Provides additional information or detailed specification of the machine function 
and feature.

The date format may differ from country 
to country.

Caution Gives users information to protect the machine from possible mechanical 
damage or malfunction.

Do not touch the green underside of the 
toner cartridge. 

Footnote Provides additional more detailed information on certain words or a phrase. a. pages per minute

(“Cross-reference”) Guides users to a reference page for the additional detailed information. (See "Finding more information" on 
page 14.)
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FINDING MORE INFORMATION
You can find information for setting up and using your machine from the following resources, either from a print-out or on screen.

MATERIAL NAME DESCRIPTION

Quick Install Guide This guide provides basic information on setting up your machine.

User’s Guide This guide provides you with step-by-step instructions for using your machine’s full features, and contains information for maintaining 
your machine, troubleshooting, and replacing supplies. 

Machine Driver Help This help provides you with information on the printer driver and instructions for setting up the options for printing (See "Using help" on 
page 44).

Samsung website If you have Internet access, you can get help, support, machine drivers, manuals, and order information from the Samsung website,
www.samsung.com/printer.

Downloadable 
software

You can download useful software programs from the Samsung website. 
• SyncThruTM Web Admin Service: convenient for network administrators who need to manage many machines simultaneously. 

This software is for network models only. (http://solution.samsungprinter.com)
• Samsung AnyWeb Print: helps personal users to screen-capture the website screen in Windows Internet Explorer easily. 

(http://solution.samsungprinter.com/personal/anywebprint)
• Samsung Easy Color Manager: helps users to adjust color as they like. 

(http://solution.samsungprinter.com/personal/colormanager)
• XPS printer driver: used to print documents in XPS print path. XPS printer driver can be installed only on Windows Vista or higher.

(http://www.samsung.com/printer)
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features of your new product
Your new machine is equipped with a number of special features that improve the quality of the documents you print.

SPECIAL FEATURES

Print with excellent quality and speed

• You can print in a full range of colors using cyan, magenta, 
yellow, and black.

• You can print with a resolution of up to 9600 x 600 dpi 
effective output.

• Your machine prints A4-sized paper at up to 20 ppm 
(CLP-620 Series), 24 ppm (CLP-670 Series) and letter-sized 
paper at up to 21 ppm (CLP-620 Series), 25 ppm (CLP-670 
Series).

Handle many different types of printable material

• The multi-purpose tray supports letterhead, envelopes, 
labels, custom-sized media, postcards, and heavy paper. 
The multi-purpose tray holds up to 100 sheets of plain paper.

• The tray 1 and optional tray support plain paper in various 
sizes.

Create professional documents (Windows only)

• Print Watermarks. You can customize your documents with 
words, such as “Confidential” (See "Using watermarks" on 
page 46).

• Print Posters. The text and pictures of each page of your 
document are magnified and printed across the sheet of 
paper and can then be taped together to form a poster (See 
"Printing posters" on page 44).

• You can use preprinted forms and letterhead with plain 
paper (See "Using overlay (PCL driver only)" on page 46).

Save time and money

• To save paper, you can print multiple pages on one single 
sheet of paper (See "Printing multiple pages on one sheet of 
paper" on page 44).

• This machine automatically conserves electricity by 
substantially reducing power consumption when not in use.

• To save paper, you can print on both sides of the paper 
(double-sided printing) (See "Printing on both sides of paper" 
on page 45).

Expand your machine’s capacity

• This machine has an extra memory slot for adding more 
memory (See "Available accessories" on page 81).

• Zoran IPS Emulation* compatible with PostScript 3 (PS) 
enables PS printing.

* Zoran IPS Emulation compatible with PostScript 3
©Copyright 1995-2005, Zoran Corporation. All rights reserved. 
Zoran, the Zoran logo, IPS/PS3, and OneImage are trademarks 
of Zoran Corporation.

136 PS3 fonts
Contains UFST and MicroType from Monotype Imaging Inc.

Print in various environments

• You can print with Windows operating systems as well as 
Linux, Macintosh and UNIX systems.

• Your machine is equipped with a USB interface and a 
network interface.

IPv6

This machine supports IPv6.
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FEATURES BY MODELS
The machine is designed to support all of your document needs from printing to more advanced networking solutions for your business.
Some features and optional goods may not be available depending on models or countries. 
Features by models include:

FEATURES CLP-62OND SERIES CLP-670N SERIES CLP-670ND SERIES

USB 2.0

Network Interface Ethernet 10/100 BaseTX wired LAN

Duplex (2-sided) printing

( : Included, : Optional) 
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1.introduction
These are the main components of your machine:
This chapter includes:
• Machine overview
• Control panel overview

• Understanding the status LED
• Turning on the machine

MACHINE OVERVIEW
Front view

1 Output tray 8 Front cover handle

2 Output support 9 Front cover

3 Paper level indicator 10 Control panel

4 Optional traya

a.This is an optional feature.

11 Paper width guides on a 
multi-purpose tray

5 Tray 1 12 Toner cartridges

6 Multi-purpose tray 13 Paper transfer belt

7 Multi-purpose tray handle
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Rear view

1 Control board cover 5 Optional tray2 cable 
connector

2 Power receptacle 6 Network port

3 Power-switch 7 USB port

4 Handle
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CONTROL PANEL OVERVIEW

1 Display Shows the current status and prompts during an operation. 

2 Toner colors Show the status of each toner cartridge (See "Understanding the status LED" on page 20).

3 Menu Enters menu mode and scrolls through the available menus (See "Accessing the Menu" on page 54).

4 Back Sends you back to the upper menu level.

5 Arrow Scroll through the options available in the selected menu, and increase or decrease values.

6 OK Confirms the selection on the screen.

7 Stop Stops an operation at any time. The pop-up window appears on the screen showing the current job that the user can stop or 
resume.

8 Power Sends the machine into power saver mode. You can also turn the power on and off with this button (See "Introducing the useful 
Buttons" on page 20).

9 Status LED Shows the status of your machine (See "Understanding the status LED" on page 20).
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UNDERSTANDING THE STATUS LED

Status LED
The color of the status LED indicates the machine's current status.

STATUS DESCRIPTION

Off The machine is off-line.

Green Blinking • When the LED blinks slowly, the machine is 
receiving data from the computer.

• When the LED blinks rapidly, the machine is 
printing data. 

On • The machine is on-line and can be used.
• The machine is in power saver mode. When 

data is received, or any button is pressed, it 
switches to on-line automatically.

Red Blinking • A minor error has occurred and the machine is 
waiting for the error to be cleared. Check the 
display message. When the problem is 
cleared, the machine resumes. 

• Small amount of toner is left in the cartridge. 
The estimated cartridge lifea

a.Estimated cartridge life means the expected or estimated toner 
cartridge life, which indicates the average capacity of print-outs and is 
designed pursuant to ISO/IEC 19798. The number of pages may be 
affected by the percent of image area of your originals, operating 
environment, printing interval, media type, and media size. Some 
amount of toner may remain in the cartridge even when red LED is 
turned on and the printer stops printing. 

 of toner is close. 
Prepare a new cartridge for replacement. You 
may temporarily increase the printing quality 
by redistributing the toner (See "Redistributing 
toner" on page 65).

On • A toner cartridge has almost reached its 
estimated cartridge lifea. It is recommended to 
replace the toner cartridge (See "Replacing
the toner cartridge" on page 82).

• A paper jam has occurred (See "Clearing 
paper jams" on page 67).

• The cover is opened. Close the cover.
• There is no paper in the tray. Load paper in 

the tray.
• The machine has stopped due to a major 

error. Check the display message (See 
"Understanding display messages" on 
page 70).

Samsung does not recommend using non-genuine Samsung toner 
cartridge such as one refilled or remanufactured. Samsung cannot 
guarantee non-genuine Samsung toner cartridge's quality. Service or 
repair required as a result of using non-genuine Samsung toner 
cartridges will not be covered under the machine warranty. 

• Check the message on the display. Follow the instructions in the 
display or refer to troubleshooting part (See "Understanding 
display messages" on page 70). If the problem persists, call for 
service.

• All printing errors will be appear in the Smart Panel program 

window. If the problem persists, call for service.

INTRODUCING THE USEFUL BUTTONS

(Menu button)

When you want to know the machine status and set your machine to use 
advanced features, press  (See "Accessing the Menu" on page 54).

(Stop button)

By pressing the , you can: 

FUNCTION DESCRIPTION

Cancel print job Press  during printing.

(Power button)

When the machine is not in use, save electricity by pressing the .
Pressing this button for one second puts the machine into the power save 
mode (See "Using the power saving feature" on page 34).

When you want to turn the power off, press the  until Power Down
message appears. 

STATUS DESCRIPTION

Off • The machine is in ready mode.
• The machine’s power is off.

On The machine is in power save mode.

TURNING ON THE MACHINE
1. Plug in the power cord.
2. Turn the power-switch on.

3. Press the .

If you want to turn the power off, press this button until Power Down
appears
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2.getting started
This chapter gives you step-by-step instructions for setting up the USB connected machine and software.

• Setting up the hardware
• Printing a demo page
• Supplied software

• System requirements
• Installing USB connected machine’s driver
• Sharing your machine locally

SETTING UP THE HARDWARE
This section shows the steps to set up the hardware, as is explained in the 
Quick Install Guide. Make sure you read the Quick Install Guide first and 
follow the steps below:
1. Select a stable location.

Select a level, stable place with adequate space for air circulation. Allow 
extra space to open covers and trays. 
The area should be well ventilated and away from direct sunlight or 
sources of heat, cold, and humidity. Do not set the machine close to the 
edge of your desk or table.

Printing is suitable for altitudes under 1,000 m (3,281 ft). Refer to the 
altitude setting to optimize your printing (See "Altitude adjustment" on 
page 34).
Place the machine on a flat, stable surface so that there is no incline 
greater than 2 mm (0.08 inch). Otherwise, printing quality may be 
affected.

2. Unpack the machine and check all the enclosed items.
3. Remove all tape.
4. Install the toner cartridges.
5. Load paper (See "Loading paper in the tray" on page 37).
6. Make sure that all cables are connected to the machine. 
7. Turn the machine on.

This equipment will be inoperable when mains power fails.

PRINTING A DEMO PAGE
Print a demo page to make sure that the machine is operating correctly.
To print a demo page:

1. Press  on the control panel.
2. Press left/right arrow until Information appears and press OK.
3. Press the left/right arrow button until Demo Page appears and press 

OK.
4. Press left/right arrow until Print? appears and press OK.

The machine starts to print a demo page.

SUPPLIED SOFTWARE
After you have set up your machine and connected it to your computer, you 
must install the printer software. If you are a Windows or Macintosh OS 
user, install the software from the supplied CD and if you are a Linux OS or 
UNIX OS user, download the software from the Samsung website 
(www.samsung.com/printer) and install.



OS CONTENTS

Windows • Printer driver: Use this driver to take full advantage of 
your machine’s features.

• PostScript printer driver (CLP-670 Series only):
Use the PostScript driver to print documents with 
complex fonts and graphics in the PS language. 
(PostScript printer description file is included.)

• Smart Panel: This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

• SetIP: Use this program to set your machine’s TCP/IP 
addresses.

Macintosh • Printer driver (CLP-620 Series Only): Use this driver 
to take full advantage of your machine’s features.

• PostScript printer driver (CLP-670 Series only):
Use this driver to run your machine from a Macintosh 
computer and print documents. (PostScript printer 
description file is included.)

• Smart Panel: This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

• SetIP: Use this program to set your machine’s TCP/IP 
addresses.

Linux • Printer driver (CLP-620 Series Only): Use this driver 
to take full advantage of your machine’s features.

• PostScript printer driver (CLP-670 Series only):
Use this driver to run your machine from a Linux 
computer and print documents. (PostScript printer 
description file is included.)

• Smart Panel: This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

• SetIP: Use this program to set your machine’s TCP/IP 
addresses.

UNIX • UNIX Printer driver: Use this driver to print 
documents from the UNIX system.
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SYSTEM REQUIREMENTS
Before you begin, ensure that your system meets the following 
requirements:

Windows
Your machine supports the following Windows operating systems.

OPERATING 
SYSTEM

REQUIREMENT (RECOMMENDED)

CPU RAM FREE HDD 
SPACE

Windows 2000 Pentium II 400 MHz 
(Pentium III 933 MHz)

64 MB 
(128 MB)

600 MB

Windows XP Pentium III 933 MHz 
(Pentium IV 1 GHz)

128 MB 
(256 MB)

1.5 GB

Windows 
Server 2003

Pentium III 933 MHz 
(Pentium IV 1 GHz)

128 MB 
(512 MB)

1.25 GB to 
2 GB

Windows 
Server 2008

Pentium IV 1 GHz 
(Pentium IV 2 GHz)

512 MB 
(2048 MB)

10 GB

Windows Vista Pentium IV 3 GHz 512 MB 
(1024 MB)

15 GB

Windows 7 Pentium IV 1 GHz 32-bit 
or 64-bit processor or 
higher

1 GB (2 
GB)

16 GB

• Support for DirectX 9 graphics with 128 MB memory 
(to enable the Aero theme).

• DVD-R/W Drive

Windows 
Server 2008 R2

Pentium IV 1 GHz (x86) 
or 1.4 GHz (x64) 
processors (2 GHz or 
faster)

512 MB 
(2048 MB)

10 GB

• Internet Explorer 5.0 or higher is the minimum requirement for all 
Windows operating systems.

• Users who have an administrator right can install the software.
• Windows Terminal Services is compatible with this machine.

Macintosh

OPERATING 
SYSTEM

REQUIREMENTS (RECOMMENDED)

CPU RAM FREE HDD 
SPACE

Mac OS X 
10.3 ~10.4

• Intel 
Processors

• PowerPC G4/ 
G5

• 128 MB for a 
PowerPC based 
Mac (512 MB)

• 512 MB for a 
Intel-based Mac 
(1 GB)

1 GB

Mac OS X 
10.5

• Intel 
Processors

• 867 MHz or 
faster Power 
PC G4/ G5

512 MB (1 GB) 1 GB

Mac OS X 
10.6

• Intel 
Processors

1 GB (2 GB) 1 GB 

OPERATING 
SYSTEM

REQUIREMENT (RECOMMENDED)

CPU RAM FREE HDD 
SPACE
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Linux
ITEM REQUIREMENTS

Operating 
system

RedHat Enterprise Linux WS 4, 5 (32/64 bit)
Fedora Core 2~10 (32/64 bit)
SuSE Linux 9.1 (32 bit)
OpenSuSE 9.2, 9.3, 10.0, 10.1, 10.2  10.3, 11.0
11.1 (32/64 bit) 
Mandrake 10.0, 10.1 (32/64 bit)
Mandriva 2005, 2006, 2007, 2008, 2009 (32/64 bit) 
Ubuntu 6.06, 6.10, 7.04, 7.10, 8.04  8.10 (32/64 bit)
SuSE Linux Enterprise Desktop 9, 10 (32/64 bit)
Debian 3.1, 4.0, 5.0 (32/64 bit) 

CPU Pentium IV 2.4 GHz (IntelCore2)

RAM 512 MB (1024 MB)

Free HDD space 1 GB (2 GB)

UNIX
ITEM REQUIREMENTS

Operating 
system

Sun Solaris / SPARC
Sun Solaris / x86
HP-UX / PA-RISC
HP-UX / Itanium
IBM AIX / Power

Free HDD space Up to 100 MB

INSTALLING USB CONNECTED MACHINE’S 
DRIVER
A locally connected machine is a machine directly attached to your 
computer using the USB cable. If your machine is attached to a network, 
skip the following steps below and go on to installing network connected 
machine’s driver (See "Installing network connected machine’s driver" on 
page 29).

Only use an USB cable no longer then 3 m (10 ft.).

Windows
You can install the machine software using the typical or custom method.
The following steps below are recommended for most users who use a 
machine directly connected to your computer. All components necessary for 
machine operations will be installed.
1. Make sure that the machine is connected to your computer and powered 

on.
If the “Found New Hardware Wizard” window appears during the 
installation procedure, click  in the upper right corner of the box 
to close the window, or click Cancel.

2. Insert the supplied software CD into your CD-ROM drive.
• The software CD should automatically run and an installation window 

appears.
• If the installation window does not appear, click Start and then Run.

Type X:\Setup.exe, replacing “X” with the letter which represents 
your drive. Click OK.

• If you use Windows Vista, Windows 7 and Windows 2008 Server R2 

click Start > All programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your drive and click OK.

• If the AutoPlay window appears in Windows Vista, click Run
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.

• If the AutoPlay window appears in Windows 7 and Windows 2008 
Server R2, click Run Setup.exe in Install or run program field, and 
click Yes in the User Account Control windows.

3. Select Install now.

If necessary, select a language from the drop-down list.
• The Advanced Installation has two options, Custom 

Installation and Install Software Only. Custom Installation
allows you to select the machine’s connection and choose 
individual component to install. Install Software Only allows 
you to install the supplied software programs, such as Smart 
Panel. Follow the instruction on the window.

• Administrator Installation provides convenient installation 
methods useful for administrators (See "Administrator’s Guide 
(Windows only)" on page 91).

4. Read License Agreement, and check I accept the terms of the 
License Agreement. Then, click Next.

The program searches the machine.
If your machine is not found in the network or locally, the following 
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window will appear.

• Check if you want to install the software without 
connecting the printer to the network or locally.
- Check this option to install the software without a machine 

connected. In this case, the print a test page window will be 
skipped.

• Search again
- Press this button to research connected machine.
- When you click this button, the firewall notice window 

appears;
Turn off the firewall and click Search again. For Windows 
operating system, click Start > Control Panel > Windows 
Firewall, and inactivate this option. 
Then click Next in the Firewall Notice window. 
Turn off the firewall from the third party's program beside 
the operating system. Refer to the manual provided by 
individual programs.

• Direct Input
- The Direct Input allows you to search a specific machine 

on the network.

- Search by IP address: Enter the IP address or the host 
name. Then click Next.
To verify your machine’s IP address, print a network 
configuration report (See "Printing a machine report" on 
page 62).

- Search by network path: To find a shared machine (UNC 
Path), enter the shared name manually or find a shared 
printer by clicking the Browse button. Then click Next.

• Help
- If your machine is not connected to the computer or 

network, This help button gives detailed information about 
the how to connect the machine.

• Set IP Address
- If you want to set a specific IP address on a specific 

network machine, click the Set IP Address button. The Set
IP Address window appears. Do as follows:

a) Select a machine to be set with a specific IP address from 
the list.

b) Configure an IP address, subnet mask, and gateway for the 
machine manually and click Apply to set the specific IP 

address for the network machine.
c) Click Next.

5. When the printer connection confirmation window appears, check the 
printer name and click Next.

6. After the installation is finished, a window asking you to print a test page 
appears. If you want to print a test page, click Print a test page.
Otherwise, just click Next and skip to step 7.

7. If the test page prints out correctly, click Yes.
If not, click No to reprint it.

8. To register as a user of the machine in order to receive information from 
Samsung, click On-line Registration. You are now registered to the 
Samsung web site.

9. Click Finish.
If the printer driver does not work properly, follow the steps below to 
repair or reinstall the driver. 
a) Make sure that the machine is connected to your computer and 

powered on.
b) From the Start menu, select Programs or All Programs > 

Samsung Printers > your printer driver name > Maintenance.
c) Select the option as you wish, follow the instruction on the window.

Macintosh
The software CD that came with your machine provides you with the PPD 
file that allows you to use the CUPS driver or Apple LaserWriter driver (only 
available when you use a machine which supports the PostScript driver) for 
printing on a Macintosh computer. 
1. Make sure that the machine is connected to your computer and powered 

on.
2. Insert the supplied software CD into your CD-ROM drive.
3. Double-click the CD-ROM icon that appears on your Macintosh desktop.
4. Double-click the MAC_Installer folder.
5. Double-click the Installer OS X icon.
6. Enter the password and click OK.
7. The Samsung Installer window opens. Click Continue.
8. Read the license agreement and click Continue.
9. Click Agree to agree to the license agreement.
10. Select Easy Install and click Install. Easy Install is recommended for 

most users. All components necessary for machine operations will be 
installed. 
If you select Custom Install, you can choose individual components to 
install.

11. When the message which warns that all applications will close on your 
computer appears, click Continue.

If a window asking you to select an installation type appears, 
select Typical installation for a local printer and then click OK

12. After the installation is finished, click Quit.
13. Open the Applications folder > Utilities > Print Setup Utility.

• For Mac OS X 10.5~10.6, open the Applications folder > System
Preferences and click Print and Fax.

14. Click Add on the Printer List.
• For Mac OS X 10.5~10.6, click the “+” icon; a display window will pop 

up.
15. For Mac OS X 10.3, select the USB tab. 

• For Mac OS X10.4, click Default Browser and find the USB 
connection.

• For Mac OS X 10.5~10.6, click Default and find the USB connection.
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16. For Mac OS X 10.3, if Auto Select does not work properly, select 
Samsung in Printer Model and your machine name in Model Name.
• For Mac OS X 10.4, if Auto Select does not work properly, select 

Samsung in Print Using and your machine name in Model.
• For Mac OS X 10.5~10.6, if Auto Select does not work properly, 

select Select a driver to use... and your machine name in Print
Using.

Your machine appears on the Printer List, and is set as the default 
machine.

17. Click Add.
If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow steps below to uninstall the driver for Macintosh.
a) Make sure that the machine is connected to your computer and 

powered on.
b) Insert the supplied software CD into your CD-ROM drive.
c) Double-click CD-ROM icon that appears on your Macintosh 

desktop.
d) Double-click the MAC_Installer folder.
e) Double-click the Installer OS X icon.
f) Enter the password and click OK.
g) The Samsung Installer window opens. Click Continue.
h) Select Uninstall and click Uninstall.
i) When the message which warns that all applications will close on 

your computer appears, Click Continue.
j) When the uninstall is done, click Quit.

Linux
You need to download Linux software packages from the Samsung website 
to install the printer software. 
Follow the steps below to install the software.

Installing the Unified Linux Driver
1. Make sure that the machine is connected to your computer and 

powered on.
2. When the Administrator Login window appears, type in root in the 

Login field and enter the system password.

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 
administrator.

3. From the Samsung website, download and unpack the Unified Linux 
Driver package to your computer.

4. Click  at the bottom of the desktop. When the Terminal screen 
appears, type in the following:
[root@localhost root]#tar zxf [FilePath]/UnifiedLinuxDriver.tar.gz
[root@localhost root]#cd [FilePath]/cdroot/Linux
[root@localhost Linux]#./install.sh

If you do not use the graphical interface and failed to install the 
software, you have to use the driver in the text mode. Follow 
the steps 3 to 4, and then follow the instructions on the terminal 
screen.

5. When the welcome screen appears, click Next.

6. When the installation is complete, click Finish.
The installation program has added the Unified Driver Configurator 
desktop icon and the Unified Driver group to the system menu for your 
convenience. If you have any difficulties, consult the on screen help that 
is available through your system menu or can otherwise be called from 
the driver package Windows applications, such as Unified Driver 
Configurator or Image Manager.

Installing the SmartPanel
1. Make sure that the machine is connected to your computer and 

powered on.
2. When the Administrator Login window appears, type in root in the 

Login field and enter the system password.

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 
administrator.

3. From the Samsung website, download and unpack the Smart Panel 
package to your computer.

4. Click  at the bottom of the desktop. When the Terminal screen 
appears, type in the following:
[root@localhost root]#tar zxf [FilePath]/SmartPanel.tar.gz
[root@localhost root]#cd [FilePath]/cdroot/Linux/smartpanel
[root@localhost smartpanel]#./install.sh

If you do not use the graphical interface and failed to install the 
software, you have to use the driver in the text mode. Follow 
the steps 3 to 4, and then follow the instructions on the terminal 
screen.

Installing the Printer Setting Utility
1. Make sure that the machine is connected to your computer and 

powered on.
2. When the Administrator Login window appears, type in root in the 

Login field and enter the system password.

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 
administrator.

3. From the Samsung website, download and unpack the Printer 
Setting Utility package to your computer.

4. Click  at the bottom of the desktop. When the Terminal screen 
appears, type in the following:
[root@localhost root]#tar zxf [FilePath]/PSU.tar.gz
[root@localhost root]#cd [FilePath]/cdroot/Linux/psu



Getting started_ 26

[root@localhost psu]#./install.sh
If you do not use the graphical interface and failed to install the 
software, you have to use the driver in the text mode. Follow steps 
3 to 4, and then follow the instructions on the terminal screen.

If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow the steps below steps to uninstall the driver for Linux.
a) Make sure that the machine is connected to your computer and 

powered on.
b) When the Administrator Login window appears, type in “root” 

in the Login field and enter the system password.
You must log in as a super user (root) to uninstall the printer 
driver. If you are not a super user, ask your system 
administrator.

c) Click the icon at the bottom of the desktop. When the Terminal 
screen appears, type in:
[root@localhost root]#cd /opt/Samsung/mfp/uninstall/
[root@localhost uninstall]#./uninstall.sh

d) Click Uninstall.
e) Click Next.
f) Click Finish.

SHARING YOUR MACHINE LOCALLY
Follow the steps below to set up the computers to share your machine 
locally.
If the Host computer is directly connected to the machine with a USB cable 
and is also connected to the local network environment, the client computer 
connected to the local network can use the shared machine through the 
host computer to print. 

1
Host computer A computer which is directly connected to 

the machine by USB cable.

2
Client computers Computers which use the machine shared 

through the host computer. 

Windows
Setting up a host computer
1. Install your printer driver. (See "Installing USB connected machine’s 

driver" on page 23, "Installing network connected machine’s driver" 
on page 29.)

2. Click the Windows Start menu. 
3. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printer and Faxes.
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers.
• For Windows 7, select Control Panel > Hardware and Sound >

Devices and Printers.
• For Windows Server 2008 R2, select Control Panel > Hardware 

> Devices and Printers.
4. Right click your printer icon. 
5. For Windows XP/2003/2008/Vista, press Properties.

For Windows 7 and Windows Server 2008 R2, from context menus, 
select the Printer properties.

If Printer properties item has  mark, you can select other 
printer drivers connected with selected printer.

6. Select the Sharing tab.
7. Check the Change Sharing Options.
8. Check the Share this printer.
9. Fill in the Share Name field. Click OK.

Setting up a client computer
1. Install your printer driver (See "Installing USB connected machine’s 

driver" on page 23, "Installing network connected machine’s driver" 
on page 29).

2. Click the Windows Start menu. 
3. Select All programs > Accessories > Windows Explorer.
4. Enter the IP address of the host computer in the address bar and 

press Enter in your keyboard. 

In case host computer requires User name and Password, fill 
in User ID and password of the host computer account.

5. Right click the printer icon you want to share and select Connect.
6. If a set up complete message appears, click OK.
7. Open the file you want to print and start printing. 

Macintosh
The following steps are for Mac OS X 10.5~10.6. Refer to Mac Help 
for other OS versions. 

Setting up a host computer
1. Install your printer driver. (See "Macintosh" on page 24.)
2. Open the Applications folder > System Preferences and click 

Print & Fax.
3. Select the printer to share in the Printers list.
4. Select Share this printer.

Setting up a client computer
1. Install your printer driver (See "Macintosh" on page 24).
2. Open the Applications folder > System Preferences and click 

Print and Fax.
3. Click the “+” icon. 

A display window showing the name of your shared printer appears.
4. Select your machine and click Add.
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3.network setup
This chapter gives you step-by-step instructions for setting up the network connected machine and software.
This chapter includes:
• Network environment
• Introducing useful network programs
• Using a wired network

• Installing network connected machine’s driver
• IPv6 Configuration
• Restoring factory default settings

• If you are using wired network environment, see "Using a wired 
network" on page 27.

NETWORK ENVIRONMENT
You need to set up the network protocols on the machine to use it as your 
network machine. You can set up the basic network settings through the 
machine's control panel.
The following table shows the network environments supported by the 
machine:

ITEM REQUIREMENTS

Network interface • Ethernet 10/100 Base-TX

Network operating system • Windows 2000/XP/2003/2008/Vista
• Various Linux OS
• Mac OS X 10.3 ~ 10.6
• UNIX

Network protocols • TCP/IPv4
• DHCP, BOOTP
• DNS, WINS, Bonjour, SLP, UPnP
• Standard TCP/IP Printing(RAW), LPR, 

IPP, WSD
• SNMPv 1/2/3, HTTP(S), Telnet, 

SMTP(S), LDAP(S), IPSec
• TCP/IPv6 (DHCP, DNS, RAW, LPR, 

SNMPv 1/2/3, HTTP(S), IPSec)
(See "IPv6 Configuration" on page 32).

INTRODUCING USEFUL NETWORK PROGRAMS
There are several programs available to setup the network settings easily in 
network environment. For the network administrator especially, managing 
several machines on the network is possible. 

Before using the programs below, set the IP adress first.

SyncThru™ Web Service
Web server embedded on your network machine, which allows you to:
• Configure the network parameters necessary for the machine to connect 

to various network environments.
• Customize machine settings

(See "Using SyncThru™ Web Service" on page 58).

SyncThru™ Web Admin Service
Web-based machine management solution for network administrators. 
SyncThru™ Web Admin Service provides you with an efficient way of 
managing network devices and lets you remotely monitor and troubleshoot 
network machines from any site with corporate internet access. Download 
this program from http://solution.samsungprinter.com.

SetIP
This utility program allows you to select a network interface and manually 
configure the IP addresses for use with the TCP/IP protocol (See "IPv4
setting using SetIP Program (Windows)" on page 28 or "IPv4 setting using 
SetIP Program (Macintosh)" on page 28).

TCP/IPv6 is not supported by this program.

USING A WIRED NETWORK
You must set up the network protocols on your machine to use it on your 
network. This chapter will show you how this is easily accomplished.
You can use network after connecting network cable to a corresponding 
port on your machine. 

Printing Network Configuration report
You can print a Network Configuration Report from the machine’s control 
panel that will show the current machine’s network settings. This will help 
you to set up a network and troubleshoot problems.

1. Press  on the control panel.
2. Press left/right arrow until Network appears and press OK.
3. Press left/right arrow until Network Info. appears.
4. When Print? shows, press right/left arrow to choose Yes.
5. Press OK.
Using this Network Configuration Report, you can find your machine MAC 
address and IP address.
For example:
• MAC Address: 00:15:99:41:A2:78
• IP Address: 192.0.0.192
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Setting IPv4 address
First, you have to set up an IPv4 address for network printing and 
management. In most cases a new IP address will be automatically 
assigned by a DHCP (Dynamic Host Configuration Protocol) server located 
on the network.

If you use IPv6 address, refer to "IPv6 Configuration" on page 32.

In a few situations the IP address must be set manually. This is called a 
static IP and is often required in corporate Intranets for security reasons.
• DHCP IP assignment: Connect your machine to the network, and wait a 

few minutes for the DHCP server to assign an IP address to the 
machine. Then, print the Network Configuration Report as explained 
above. If the report shows that the IP address has changed, the 
assignment was successful. You will see the new IP address in the 
report.

• Static IP assignment: Use SetIP program to change the IP address 
from your computer. You can also change IP address using the 
machine's control panel.

In an office environment, we recommend that you contact a network 
administrator to set this address for you.

IPv4 setting using control panel
1. Connect your machine to the network with a network cable.
2. Turn on the machine.
3. Press  on the control panel.
4. Press left/right arrow until Network appears and press OK.
5. Press left/right arrow until TCP/IP (IPv4) appears and press OK.
6. Press left/right arrow until Static appears and press OK.
7. The first available menu item, IP Address appears. Press OK.

• Enter a number between 0 and 255.
• Use the left/right arrow to enter digits. When you press OK, the 

cursor will move to the next character. When you finish entering 
the IP address, press OK.

8. Press  to go to the upper level.
9. Press left/right arrow until Subnet Mask appears and press OK.

• Enter a number between 0 and 255.
• Use the left/right arrow to enter digits. When you press OK, the 

cursor will move to the next character. When you finish entering 
the Subnet Mask, press OK.

10. Press  to go to the upper level.
11. Press left/right arrow until Gateway appears and press OK.

• Enter a number between 0 and 255.
• Use the left/right arrow to enter digits. When you press OK,

cursor will move to the next character. When you finish entering 
the Gateway, press OK.

12. After entering all parameters, press  to return to ready mode.
Now go to "Installing network connected machine’s driver" on page 29.

IPv4 setting using SetIP Program (Windows)
This program is for manually setting the network IPv4 address of your 
machine using its MAC address to communicate with the machine. A 
MAC address is the hardware serial number of the network interface and 
can be found in the Network Configuration Report.
For using SetIP program, disable the computer firewall before continuing 
by performing the following:
1. Open Control Panel.
2. Double click Security Center.

3. Click Windows Firewall.
4. Disable the firewall.

Installing the program
1. Insert the Printer Software CD-ROM provided with your machine. 

When the driver CD runs automatically, close that window.
2. Start Windows Explorer and open the X drive. (X represents your 

CD-ROM drive.)
3. Double-click Application > SetIP.
4. Double-click Setup.exe to install this program.
5. Click OK. If necessary, select a language from the drop-down list.
6. Follow the instructions in the window and complete the installation.

Starting the program
1. Connect your machine to the network with a network cable.
2. Turned on the machine.
3. From the Windows Start menu, select All Programs > Samsung 

Network Printer Utilities > SetIP > SetIP.

4. Click on the  icon (third from left) in the SetIP window to open the 
TCP/IP configuration window.

5. Enter the machine’s new information into the configuration window 
as follows. In a corporate intranet, you may need to have this 
information assigned by a network manager before proceeding.

• MAC Address: Find the machine’s MAC address from the 
Network Configuration Report and enter it without the colons. For 
example, 00:15:99:29:51:A8 becomes 0015992951A8.

• IP Address: Enter a new IP address for your printer. For 
example, if your computer’s IP address is 192.168.1.150, enter 
192.168.1.X. (X is number between 1 and 254 other than the 
computer’s address.)

• Subnet Mask: Enter a Subnet Mask.
• Default Gateway: Enter a Default Gateway.

6. Click Apply, and then click OK. The machine will automatically print 
the Network Configuration Report. Confirm that all the settings are 
correct.

7. Click Exit to close the SetIP program.
8. If necessary, restart the computer’s firewall.

IPv4 setting using SetIP Program (Macintosh)
For using SetIP program, disable the computer firewall before continuing 
by performing the following:

The path and UIs may differ by Mac OS version. Refer to the Mac 
OS manual to turn firewall off.
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1. Open System Preferences.
2. Click Security.
3. Click the Firewall menu.
4. Turn firewall off.

The following instructions may vary for your model.

Follow the next procedure to configure IP address:
1. Connect your machine to the network with a network cable.
2. Insert the Installation CD-ROM, and open the disk window, select 

MAC_Installer > MAC_Printer > SetIP > SetIPapplet.html.
3. Double click the file and Safari will automatically open, then select 

Trust. The browser will open the SetIPapplet.html page that shows 
the printer’s name and IP address information. 

4. Click on the  icon (third from left) in the SetIP window to open the 
TCP/IP configuration window.

5. Enter the machine’s new information into the configuration window 
as follows. In a corporate intranet, you may need to have this 
information assigned by a network manager before proceeding.
• MAC Address: Find the machine’s MAC address from the 

Network Configuration Report and enter it without the colons. For 
example, 00:15:99:29:51:A8 becomes 0015992951A8.

• IP Address: Enter a new IP address for your printer. For 
example, if your computer’s IP address is 192.168.1.150, enter 
192.168.1.X. (X is number between 1 and 254 other than the 
computer’s address.)

• Subnet Mask: Enter a Subnet Mask.
• Default Gateway: Enter a Default Gateway.

6. Select Apply, then OK, and OK again. The printer will automatically 
print the configuration report. Confirm that all the settings are correct. 
Quit Safari. You may close and eject the installation CD-ROM. If 
necessary, restart the computer’s firewall. You have successfully 
changed the IP address, subnet mask, and gateway.

IPv4 setting using SetIP Program (Linux)
SetIP program should be automatically installed during the printer driver 
installation.
For using SetIP program, disable the computer firewall before continuing 
by performing the following:

The path and UIs may differ by Linux OS version. Refer to the 
Linux OS manual to turn firewall off.

1. Open System Preferences or Administrator.
2. Click the Firewall.
3. Turn firewall off.
Follow the next procedure to configure IP address:
1. Print the machine’s Network Configuration Report to find your 

machine’s MAC address.
2. Open the /opt/Samsung/mfp/share/utils.
3. Double click the SetIPApplet.html file.
4. Click to open the TCPIP configuration window.
5. Enter the network card’s MAC address, IP address, subnet mask, 

default gateway, and then click Apply.

When you enter the MAC address, enter it without a colon(:).

6. The machine prints the network configuration report. Confirm all the 
settings are correct.

7. Close the SetIP program.

INSTALLING NETWORK CONNECTED 
MACHINE’S DRIVER
You must install the printer driver software for printing. The software 
includes drivers, applications, and other user friendly programs.
Make sure that the network setup for your machine is completed. All 
applications should be closed on your computer before beginning 
installation. 

Windows
This is recommended for most users. All components necessary for 
machine operations will be installed.
Follow the steps below:
1. Make sure that the machine is connected to the network and powered 

on.
2. Insert the supplied software CD into your CD-ROM drive.

• The software CD should automatically run and an installation window 
appears.

• If the installation window does not appear, click Start and then Run.
Type X:\Setup.exe, replacing “X” with the letter which represents 
your drive. Click OK.

• If you use Windows Vista, click Start > All programs > Accessories
> Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your drive and click OK.

• If the AutoPlay window appears in Windows Vista, click Run
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.

• If the AutoPlay window appears in Windows 7 and Windows 2008 
Server R2, click Run Setup.exe in Install or run program field, and 
click Yes in the User Account Control windows.

3. Select Install now.

If necessary, select a language from the drop-down list.
• The Advanced Installation has two options, Custom 

Installation and Install Software Only. Custom Installation
allows you to select the machine’s connection and choose 
individual component to install. Install Software Only allows 
you to install the supplied software programs, such as Smart 
Panel. Follow the instruction on the window.

• Administrator Installation provides convenient installation 
methods useful for administrators (See "Administrator’s Guide 
(Windows only)" on page 91).
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4. Read License Agreement, and check I accept the terms of the 
License Agreement. Then, click Next.

The program searches the machine.
If your machine is not found in the network or locally, the following 
window will appear.

• Check if you want to install the software without 
connecting the printer to the network or locally.
- Check this option to install the software without a machine 

connected. In this case, the print a test page window will be 
skipped.

• Search again
- Press this button to research connected machine.
- When you click this button, the firewall notice window 

appears;
Turn off the firewall and click Search again. For Windows 
operating system, click Start > Control Panel > Windows 
Firewall, and inactivate this option. 
Then click Next in the Firewall Notice window. 
Turn off the firewall from the third party's program beside 
the operating system. Refer to the manual provided by 
individual programs.

• Direct Input
- The Direct Input allows you to search a specific machine 

on the network.

- Search by IP address: Enter the IP address or the host 

name. Then click Next.
To verify your machine’s IP address, print a network 
configuration report (See "Printing a machine report" on 
page 62).

- Search by network path: To find a shared machine (UNC 
Path), enter the shared name manually or find a shared 
printer by clicking the Browse button. Then click Next.

• Help
- If your machine is not connected to the computer or 

network, This help button gives detailed information about 
the how to connect the machine.

• Set IP Address
- If you want to set a specific IP address on a specific 

network machine, click the Set IP Address button. The Set 
IP Address window appears. Do as follows:

a) Select a machine to be set with a specific IP address from 
the list.

b) Configure an IP address, subnet mask, and gateway for the 
machine manually and click Apply to set the specific IP 
address for the network machine.

c) Click Next.
5. The searched machines will be shown on the screen. Select the one you 

wish to use and click Next.
If the driver searched only one machine, the confirmation window 
appears.

6. After the installation is finished, a window asking you to print a test page 
appears. If you want to print a test page, click Print a test page.
Otherwise, just click Next and skip to step 7.

7. If the test page prints out correctly, click Yes.
If not, click No to reprint it.

8. To register as a user of the machine in order to receive information from 
Samsung, click On-line Registration. You are now registered to the 
Samsung web site.

9. Click Finish.
• After the driver setup, you may enable firewall.
• If the printer driver does not work properly, follow the steps below 

to repair or reinstall the driver. 
a) Make sure that the machine is connected to your machine and 

powered on.
b) From the Start menu, select Programs or All Programs > 

Samsung Printers > your printer driver name > 
Maintenance.

c) Select the option as you wish, follow the instruction on the 
window.

Macintosh
1. Make sure that the machine is connected to your network and powered 

on. Also, your machine’s IP address should have been set. 
2. Insert the supplied software CD into your CD-ROM drive.
3. Double-click the CD-ROM icon that appears on your Macintosh desktop.
4. Double-click the MAC_Installer folder.
5. Double-click the Installer OS X icon.
6. Enter the password and click OK.
7. The Samsung Installer window opens. Click Continue.
8. Read the license agreement and click Continue.
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9. Click Agree to agree to the license agreement.
10. Select Easy Install and click Install. Easy Install is recommended for 

most users. All components necessary for machine operations will be 
installed. 
If you select Custom Install, you can choose individual components to 
install.

11. The message which warns that all applications will close on your 
computer appears. Click Continue.

• If a window asking you to select an installation type appears, 
select Typical installation for a network printer and then 
click OK.

• If you select Typical installation for a network printer, the 
SetIP program automatically runs. If the machine has already 
configured network information, close the SetIP program. Go to 
the next step.

12. After the installation is finished, click Quit.
13. Open the Applications folder > Utilities > Print Setup Utility.

• For Mac OS X 10.5~10.6, open the Applications folder > System 
Preferences and click Print and Fax.

14. Click Add on the Printer List.
• For Mac OS X 10.5~10.6, click the “+” icon; a display window will pop 

up.
15. For Mac OS X 10.3, select the IP Printing tab. 

• For Mac OS X10.4, click IP Printer.
• For Mac OS X 10.5~10.6, click IP.

16. Select Socket/HP Jet Direct in Printer Type.
When printing a document containing many pages, printing 
performance may be enhanced by choosing Socket for Printer
Type option.

17. Enter the machine’s IP address in the Printer Address field.
18. Enter the queue name in the Queue Name field. If you cannot determine 

the queue name for your machine server, try using the default queue 
first.

19. For Mac OS X 10.3, if Auto Select does not work properly, select 
Samsung in Printer Model and your machine name in Model Name.
• For Mac OS X 10.4, if Auto Select does not work properly, select 

Samsung in Print Using and your machine name in Model.
• For Mac OS X 10.5~10.6, if Auto Select does not work properly, 

select Select a driver to use... and your machine name in Print
Using.

Your machine appears on the Printer List, and is set as the default 
machine.

20. Click Add.
If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow steps below to uninstall the driver for Macintosh.
a) Make sure that the machine is connected to your computer and 

powered on.
b) Insert the supplied software CD into your CD-ROM drive.
c) Double-click CD-ROM icon that appears on your Macintosh 

desktop.
d) Double-click the MAC_Installer folder.
e) Double-click the Installer OS X icon.
f) Enter the password and click OK.
g) The Samsung Installer window opens. Click Continue.
h) Select Uninstall and click Uninstall.

i) When the message which warns that all applications will close 
on your computer appears, Click Continue.

j) When the uninstall is done, click Quit.

Linux
Install Linux Driver and add network Printer
1. Make sure that the machine is connected to your network and 

powered on. Also, your machine’s IP address should have been set. 
2. Download the Unified Linux Driver package from the Samsung 

website.
3. Extract the UnifiedLinuxDriver.tar.gz file and open the new directory.
4. Double-click the Linux folder.
5. Double-click the install.sh icon.
6. The Samsung Installer window opens. Click Continue.
7. The Add printer wizard window opens. Click Next.
8. Select Network printer and click Search button.
9. The Printer’s IP address and model name appears on list field.
10. Select your machine and click Next.
11. Input the printer description and Next
12. When the add printer is done, click Finish
13. When the install is done, click Finish

Add network Printer
1. Double-click the Unified Driver Configurator.
2. Click Add Printer…
3. The Add printer wizard window opens. Click Next.
4. Select Network printer and click the Search button.
5. The printer’s IP address and model name appears on list field.
6. Select your machine and click Next.
7. Input the printer description and Next
8. When the add printer is done, click Finish.

UNIX
To use UNIX Printer Driver, you have to install the UNIX printer driver 
package first, then setup the printer. You can download the UNIX Printer 
Driver package from the Samsung website. 

Installing the UNIX printer driver package
Installation procedure is common for all variants of UNIX OS mentioned. 
(See "UNIX" on page 23).
1. From the Samsung website, download and unpack the UNIX Printer 

Driver package to your computer. 
2. Acquire root privileges. 

su -
3. Copy appropriate driver archive to the target UNIX computer. 

See administration guide of your UNIX OS for details.

4. Unpack the UNIX printer driver package archive.
For example, on IBM AIX use the following commands.
cd /tmp
gzip –dc /cdrom/unix/packages/aix_power/aix_power.tar.gz | tar 
–xvf –
The “binaries” folder consists of binz, install, share files and folders

5. Copy the “binaries” folder to any local folder.
6. Change to the driver’s “binaries” directory.
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cd aix_power/binaries
7. Run the install script.

./install
install is the installer script file which is used to install or uninstall the 
UNIX Printer Driver package.
Use “chmod 755 install” command to give the permission to the 
installer script.

8. Execute the “. /install –c” command to verify install results.
9. Run ‘installprinter’ from the command line. This will bring up the 

Add Printer Wizard window. Setup the printer in this window 
referring the procedure next.

On some UNIX OS, for example on Solaris 10 just added 
printer may not be enabled and/or may not accept jobs. In this 
case run the following two commands on the root terminal:
accept <printer_name>
enable <printer_name>

Uninstalling the printer driver package
The uninstalling printer utility should be used to delete the printer 
installed in the system.
a) Run “uninstallprinter” command from the terminal.

It will open the Uninstall Printer Wizard
The installed printers are listed in the drop-down list

b) Select the printer to be deleted.
c) Click Delete to delete the printer from the system.
d) Execute the “. /install –d” command to uninstall the whole 

package.
e) To verify uninstall results, execute the “. /install –c” command.

To reinstall it again, use the command “. /install” to reinstall the binaries.

Setting up the printer
To add the printer to your UNIX system, run ‘installprinter’ from the 
command line. This will bring up the Add Printer Wizard window. Setup 
the printer in this window according to the following steps:
1. Type the name of the printer.
2. Select appropriate printer model from model list.
3. Enter any description corresponding to the type of the printer in the 

Type field. This is optional.
4. Specify any printer description in the Description field. This is 

optional.
5. Specify printer location in the Location field.
6. Type the IP address or DNS name of the printer in the Device

textbox for network-connected printers. On IBM AIX with jetdirect
Queue type only DNS name is possible, numeric IP address is not 
allowed.

7. Queue type shows the connection as lpd or jetdirect in the 
corresponding list box. Additionally usb type is available on Sun 
Solaris OS.

8. Select Copies to set the number of copies.
9. Check the Collate option to receive copies already sorted.
10. Check the Reverse Order option to receive copies in the reverse 

order.
11. Check the Make Default option to set this printer as default.
12. Click OK to add the printer.

IPV6 CONFIGURATION
To use the IPv6 network environment, follow the next procedure to use the 
IPv6 address:
The machine is provided with IPv6 feature on.

TCP/IPv6 is supported properly only in Windows Vista or higher.

1. Connect your machine to the network with a network cable.
2. Turned on the machine.
3. Print a Network Configuration Report from the machine’s control 

panel where you can check MAC address or IPv6 addresses.
For example:
• MAC Address: 00:15:99:41:A2:78
• IPv6 Address: [FE80::215:99FF:FE66:7701]

a) Press  on the control panel.
b) Press left/right arrow until Network appears and press OK.
c) Press left/right arrow until Network Info. appears.
d) When Print? shows, press right/left arrow to choose Yes.
e) Press OK.

4. Select Start > Control Panel > Hardware and Sound > Printers > Add
Printer from your computer.

5. Click Add a local printer on the Add Printer windows.
6. Follow the instruction on the window.

• If the machine does not work in the network environment, activate 
IPv6. Refer to the next section followed by.

• If the IPv6 network seems to be not working, set all the network 
setting to the factory defaults and try again (See "Restoring factory 
default settings" on page 33).

Activating IPv6
1. Connect your machine to the network with a network cable.
2. Turned on the machine.
3. Press  on the control panel.
4. Press left/right arrow until Network appears and press OK.
5. Press left/right arrow until TCP/IP (IPv6) appears and press OK.
6. Press left/right arrow until IPv6 Activate appears and press OK.
7. Press left/right arrow until On appears and press OK.

On is set as a default.

8. Turn the machine off and turn it on again.

Setting IPv6 addresses
Machine supports following IPv6 addresses for network printing and 
managements.
• Link-local Address: Self-configured local IPv6 address. (Address 

starts with FE80.)
• Stateless Address: Automatically configured IPv6 address by a 

network router.
• Stateful Address: IPv6 address configured by a DHCPv6 server.
• Manual Address: Manually configured IPv6 address by a user.

DHCPv6 address configuration (Stateful)
If you have a DHCPv6 server on your network, you can set one of the 
following option for default dynamic host configuration:
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1. Press  on the control panel.
2. Press left/right arrow until Network and press OK.
3. Press left/right arrow until TCP/IP (IPv6) and press OK.
4. Press left/right arrow until DHCPv6 Config and press OK.
5. Press left/right arrow to access the required value.

• Routers: Use DHCPv6 only when requested by a router.
• DHCPv6 Addresses: Always use DHCPv6 regardless of router 

request.
• DHCPv6 Off: Never use DHCPv6 regardless of router request.

6. Press OK.

Manual address configuration
1. Start a web browser such as Internet Explorer that supports IPv6 

addressing as a URL (See "Connecting SyncThru™ Web Service" on 
page 33).

For IPv4, enter the IPv4 address (http://xxx.xxx.xxx.xxx) in the 
address field and press the Enter key or click Go.

2. When the SyncThru™ Web Service window opens, click Settings > 
Network Settings > Network Settings > TCP/IPv6.

3. Enable the Manual Address.
If IPv6 Protocol should be enabled. 

4. Select the Router Prefix and click the Add button, then the router prefix 
will automatically be entered into the address field. 
Enter the rest of address. (ex: 3FFE:10:88:194::AAAA. “A” is the 
hexadecimal 0 through 9, A through F.)

5. Click the Apply button.

Installing printer driver
Driver installation for network printer in IPv6 network environment is same 
as TCP/IPv4 (See "Installing network connected machine’s driver" on 
page 29).
Select TCP/IP Port and when the list of machines are displayed, simply 
select your machine's IPv6 address.

Connecting SyncThru™ Web Service
1. Start a web browser such as Internet Explorer that supports IPv6 

addressing as a URL.
2. Select one of the IPv6 addresses (Link-local Address, Stateless 

Address, Stateful Address, Manual Address) from Network 
Configuration Report.

3. Enter the IPv6 addresses. (ex: http://[FE80::215:99FF:FE66:7701]) 
Address must be enclosed in '[]' brackets.

RESTORING FACTORY DEFAULT SETTINGS
You may need to reset the machine to the factory default settings when 
machine that you are using is connected to new network environment.

Restoring factory default settings using control 
panel
1. Press  on the control panel.
2. Press left/right arrow until Network appears and press OK.
3. Press left/right arrow until Clear Setting appears and press OK.
4. When Clear? shows, press right/left arrow to choose Yes.

5. Turn off and restart machine to apply settings.

Restoring factory default settings using SyncThru™ 
Web Service
1. Start a web browser such as Internet Explorer, Safari or Firefox and 

enter your machine’s new IP address in the browser window.
For example,

2. When the SyncThru™ Web Service window opens, click Settings > 
Network Settings > Restore Default.

3. Click Clear for Network Settings.
4. Turn off and restart machine to apply settings.
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4.basic setup
After installation is complete, you may want to set the machine’s default settings. Refer to the next section if you would like
to set or change values. This chapter gives you step-by-step instructions for setting up the machine.
This chapter includes:
• Altitude adjustment
• Changing the display language
• Setting job timeout

• Using the power saving feature
• Setting the default tray and paper
• Changing font setting

ALTITUDE ADJUSTMENT
The print quality is affected by atmospheric pressure, which is determined 
by the height of the machine above sea level. The following information will 
guide you on how to set your machine to the best print quality or best quality 
of print.

Before you set the altitude value, determine the altitude where you are.

0

1 High 3
2 High 2
3 High 1
4 Normal

1. Ensure that you have installed the printer driver with the provided     
Printer Software CD.

2. Double-click the Smart Panel icon on the Windows task bar (or 
Notification Area in Linux). You can also click Smart Panel on the status 
bar in Mac OS X.

3. Click Printer Setting.
4. Click Setting > Altitude Adjustment. Select the appropriate value from 

the drop-down list, and then click Apply.
• If your machine is connected to a network, SyncThru™ Web 

Service screen appears automatically. Click Settings > Machine 
Settings > System > Setup > Altitude Adj.. Select the 
appropriate altitude value, and then click Apply.

• If your machine is connected via a USB cable, set the altitude in 
Altitude Adj. option on the machine’s display (See "System
Setup" on page 55).

CHANGING THE DISPLAY LANGUAGE
To change the language that appears on the display, follow the steps below:

1. Press  on the control panel.
2. Press left/right arrow until System Setup appears and press OK.
3. Press left/right arrow until Language appears and press OK.
4. Press left/right arrow to display the language you want.

5. press OK to save the selection.

6. Press  to return to ready mode.

SETTING JOB TIMEOUT
When there is no input for a certain period of time, the machine exits the 
current menu and goes into the default settings. You can set the amount of 
time the machine will wait.

1. Press  on the control panel.
2. Press left/right arrow until System Setup appears and press OK.
3. Press left/right arrow until Job Timeout appears and press OK.
4. Press left/right arrow to select the time you want.
5. press OK to save the selection.

6. Press  to return to ready mode.

USING THE POWER SAVING FEATURE
When you are not using the machine for a while, the machine turns to the 
power save mode. Use this feature to save power. 

1. Press  on the control panel.
2. Press left/right arrow until System Setup appears and press OK.
3. Press left/right arrow until Power Save appears and press OK.
4. Press left/right arrow to select the time you want.
5. press OK to save the selection.

6. Press  to return to ready mode.

SETTING THE DEFAULT TRAY AND PAPER
You can select the tray and paper you would like to keep using for printing 
job (See "Paper" on page 55).

In the control panel
1. Press  on the control panel.
2. Press left/right arrow until Paper appears and press OK.
3. Press left/right arrow to select the paper tray you want and press OK.
4. Press left/right arrow until Paper Size appears and press OK.
5. Press left/right arrow to select the paper size you want.
6. Press OK to save the selection.
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7. Press left/right arrow until Paper Type appears and press OK.
8. Press left/right arrow to select the paper type you want.
9. Press OK to save the selection.
10. Press .
11. Press left/right arrow until Paper Source appears and press OK.
12. Press left/right arrow to select the paper tray you want.
13. press OK to save the selection.

14. Press  to return to ready mode.

In the computer
Windows
1. Click the Windows Start menu. 
2. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printer and Faxes.
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers.
• For Windows 7, select Control Panel > Hardware and Sound >

Devices and Printers.
• For Windows Server 2008 R2, select Control Panel > Hardware 

> Devices and Printers.
3. Right-click your machine.
4. For Windows XP/2003/2008/Vista, press Printing Preferences.

For Windows 7 and Windows Server 2008 R2, from context menus, 
select the Printing Preferences.

If Printing Preferences item has  mark, you can select other 
printer drivers connected with selected printer.

5. Click Paper tab. 
6. Select tray and its options, such as paper size and type.
7. Press OK.

If you want to use special-sized paper such as a billing paper, 
select Paper tab > Size > Edit... in the Printing Preferences (See 
"Opening printing preferences" on page 44).

Macintosh
Macintosh does not support this function. Macintosh users need to 
change the default setting manually each time they want to print using 
other settings. 
1. Open a Macintosh application and select the file you want to print.
2. Open the File menu and click Print.
3. Go to Paper Feed Pane.
4. Set appropriate tray from which you want to print.
5. Go to Paper Pane.
6. Set paper type to correspond to the paper loaded in the tray from 

which you want to print.
7. Click Print to print. 

Linux
1. Open Terminal Program
2. When the Terminal screen appears, type in the following: 

[root@localhost root]# lpr <FileName>
3. Select Printer and click Properties…
4. Click Advanced tab.
5. Select tray(source) and its options, such as paper size and type.
6. Press OK.

CHANGING FONT SETTING 
Your machine has preset font setting depending on your region or country.
If you want to change the font or set the font for special condition, such as 
the DOS environment, you can change the font setting as follows:
1. Turn your networked computer on and open the web browser. 
2. Enter your machine's IP address as the URL in a browser.
3. Click Go to access the SyncThru™ Web Service.
4. Click Settings > Machine Settings > Printer > PCL.
5. Select your preferred font in the Symbol Set list.
6. Click Apply.

Following information shows the proper font list for corresponding 
languages.
• Russian: CP866, ISO 8859/5 Latin Cyrillic
• Hebrew: Hebrew 15Q, Hebrew-8, Hebrew-7 (Israel only)
• Greek: ISO 8859/7 Latin Greek, PC-8 Latin/Greek
• Arabic & Farsi: HP Arabic-8, Windows Arabic, Code Page 864, 

Farsi, ISO 8859/6 Latin Arabic
• OCR: OCR-A, OCR-B
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5.media and tray
This chapter provides information on how to load print media into your machine.
This chapter includes:
• Selecting print media
• Changing the tray size
• Loading paper in the tray

• Printing on special media
• Setting the paper Type and Size
• Using the output support

SELECTING PRINT MEDIA
You can print on a variety of print media, such as plain paper, envelopes, 
labels, and transparencies. Always use print media that meet the guidelines 
for use with your machine. 

Guidelines to select the print media
Print media that does not meet the guidelines outlined in this user’s guide 
may cause the following problems:
• Poor print quality
• Increased paper jams
• Premature wear on the machine.
Properties, such as weight, composition, grain, and moisture content, are 
important factors that affect the machine’s performance and the output 
quality. When you choose print materials, consider the following:
• The type, size and weight of the print media for your machine are 

described in print media specifications (See "Print media specifications" 
on page 89).

• Desired outcome: The print media you choose should be appropriate for 
your project.

• Brightness: Some print media are whiter than others and produce 
sharper, more vibrant images.

• Surface smoothness: The smoothness of the print media affects how 
crisp the printing looks on the paper.

• Some print media may meet all of the guidelines in this section and 
still not produce satisfactory results. This may be the result of 
improper handling, unacceptable temperature and humidity levels, 
or other variables over which cannot be controlled.

• Before purchasing large quantities of print media, ensure that it 
meets the requirements specified in this user’s guide. 

Using print media that does not meet these specifications may cause 
problems, requiring repairs. Such repairs are not covered by the 
warranty or service agreements.

The amount of paper put into the tray may differ according to media type 
used (See "Print media specifications" on page 89).

Media sizes supported in duplex mode
MODE SIZE TYPE SOURCE

Duplex 
printinga

a.60 to 120 g/m2 (16~32 lb. bond) only.
Optional for CLP-670N

Letter, A4, 
Legal, US Folio, 
Oficio

Plain, Color, 
Preprinted, 
Recycled,
Thick cb

b. If media weight is 120 g/m2 (32 lb. bond), load a paper into the 
multi-purpose tray one by one.

, Thin

c. If media weight is 60 g/m2 (16 lb. bond), select the Thin type.

• tray 1
• optional tray
• multi-purpose tray

CHANGING THE TRAY SIZE
The tray is preset to Letter or A4 size, depending on your country. To 
change the size, you need to adjust the paper guides.

1 Tray extend lever
2 Paper length guide
3 Paper width guide

1. Hold the tray with one hand, and with the other hand squeeze and slide 
the paper length guide to locate them in the correct paper size slot 
marked at the bottom of the tray. 

2. Flex or fan the edge of the paper stack to separate the pages before 
loading papers.
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3. After inserting paper into the tray, squeeze the paper width guides and 
paper length guide. Then slide them to the desired paper size marked at 
the bottom of the tray.

1 Paper length guide
2 Paper width guide

• Do not push the paper width guide too far causing the media to 
warp.

• If you do not adjust the paper width guide, it may cause paper 
jams.

LOADING PAPER IN THE TRAY
Tray 1 / optional tray
Load the print media you use for the majority of your print jobs into tray 1.
Tray 1 can hold a maximum of 250 sheets of plain paper. 
You can purchase an optional tray and attach it below the standard tray to 
load an additional 500 sheets of plain paper (See "Available supplies" on 
page 81).

Using photographic paper or coated paper may cause problems, 
requiring repairs. Such repairs are not covered by the warranty or 
service agreements.

1. Pull out tray. Then, adjust the tray size to the media size you are loading 
(See "Changing the tray size" on page 36).

2. Flex or fan the edge of the paper stack to separate the pages before 
loading papers.

3. Place paper with the side you want to print facing up.

1 Paper limit mark
2 Paper level 

indicator

Paper quantity indicator shows the amount of paper in the tray. 

1 Full
2 Empty

4. Insert the tray back into the machine.
When you print a document, set the paper type and size for the tray.
For information about setting the paper type and size on the control 
panel (See "Setting the default tray and paper" on page 34).

• If you experience problems with paper feeding, check whether 
the paper meets the media specification. Then, try placing one 
sheet at a time in the multi-purpose tray (See "Print media 
specifications" on page 89).

• The settings made from the machine driver override the 
settings on the control panel.

Multi-purpose tray
The multi-purpose tray can hold special sizes and types of print material, 
such as postcards, note cards, and envelopes. It is useful for single page 
printing on letterhead or colored paper.

Print media should be loaded face down with the top edge going into 
the multi-purpose tray first and be placed in the center of the tray.

Tips on using the multi-purpose tray
• Load only one type, size and weight of print media at a time in the 

multi-purpose tray.
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• To prevent paper jams, do not add paper while printing when there is 
still paper in the multi-purpose tray. This also applies to other types 
of print media.

• Always load the specified print media only to avoid paper jams and 
print quality problems (See "Print media specifications" on page 89).

• Flatten any curl on postcards, envelopes, and labels before loading 
them into the multi-purpose tray.

1. Hold the handle of multi-purpose tray and pull it down to open.

2. Flex or fan the edge of the paper stack to separate the pages before 
loading papers.

3. Load the paper.

4. Squeeze the multi-purpose tray paper width guides and adjust them 
to the width of the paper. Do not force them too much, or the paper 
will bent resulting in a paper jam or skew.

• When printing the special media, you must follow the 
loading guideline (See "Printing on special media" on 
page 38).

• When papers overlap when printing using Multi-purpose 
tray, open tray 1 and remove overlapping papers then try 
printing again. 

• When paper does not feed well while printing, push the 
paper in manually until it starts feeding automatically. 

5. When you print a document, set the paper type and size for the 
multi-purpose tray.
For information about setting the paper type and size on the control 
panel (See "Setting the paper Type and Size" on page 41).

The settings made from the machine driver override the 
settings on the control panel.
a) To print in application, open an application and start the print 

menu.
b) Open Printing Preferences (See "Opening printing 

preferences" on page 44).
c) Press the Paper tab in Printing Preferences, and select an 

appropriate paper type. 
For example, if you want to use a label, set the paper type to 
Label.
d) Select Manual Feeder in paper source, then press OK.
e) Start printing in application.
f) Press OK on the control panel each time you load a sheet 

of paper.
g) After printing, close the multi-purpose tray.

PRINTING ON SPECIAL MEDIA
The table below shows the available special media for each tray. 

When using special media, we recommend you feed one paper at a 
time. Check the maximum input number of media for each tray (See 
"Print media specifications" on page 89).



TYPES TRAY 1 OPTIONAL
TRAY

MULTI-PURPOSE 
TRAY

Plain

Thick 

Thicker 

Extra Thick

Thin

Cotton

Color

Preprinted

Recycled

Envelope

Transparency

Labels

CardStock

Bond

Archive

Glossy Photo 
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( : Supported, Blank: Not supported) 
The media types are shown in the Printing Preferences. This paper type 
option allows you to set the type of paper to be loaded in the tray. This 
setting appears in the list, so that you can select it. This will let you get the 
best quality printout. If not, the desired print quality may not be achieved.
• Plain: 60 to 90 g/m2 (16 to 24 lb.) Normal plain paper.
• Thick: 90 to 105 g/m2 (24 to 28 lb.) thick paper.
• Thicker: 106 to 120 g/m2 (28 to 32 lb.) thicker paper.
• Thin: 60 to 70 g/m2 (16 to 19 lb.) thin paper.
• Cotton: 75 to 90 g/m2 (20 to 24 lb.) cotton paper.
• Color: 75 to 90 g/m2 (20 to 24 lb.) color-backgrounded paper.
• Preprinted: 75 to 90 g/m2 (20 to 24 lb.) preprinted/letterhead paper.
• Recycled: 60 to 90 g/m2 (16 to 24 lb.) recycled paper.

When you use recycled paper as a used paper, printouts might be 
wrinkled.

• Envelope: 75 to 90 g/m2 (20 to 24 lb.) envelope.
• Transparency: 138 to 146 g/m2 (37 to 39 lb.) transparency paper. 
• Labels: 120 to 150 g/m2 (32 to 40 lb.) label.
• Extra Thick: 106 to 170 g/m2 (28 to 46 lb.) extra thick. 
• CardStock: 171 to 220 g/m2 (46 to 59 lb.) cardstock. 
• Bond: 105 to 120 g/m2 (28 to 32 lb.) bond. 
• Archive: 70 to 90 g/m2 (19 to 24 lb.) If you need to keep the print-out for 

a long period time, such as archives, select this option. 
• Glossy Photo: 111 to 130 g/m2 (30 to 35lb.), 131 to 175 g/m2(35 to 

47lb.), 176 to 220 g/m2 (47 to 59lb.)glossy photo paper. 

Envelope
Successful printing on envelopes depends upon the quality of the 
envelopes.
To print an envelope, place it flap side up with the stamp area bottom the 
top right side.

• When selecting envelopes, consider the following factors:
- Weight: The weight of the envelope paper should not exceed 

90 g/m2 otherwise, jam may occur.
- Construction: Prior to printing, envelopes should lie flat with less 

than 6 mm curl, and should not contain air.
- Condition: Envelopes should not be wrinkled, nicked, nor 

damaged.
- Temperature: Use envelopes that are compatible with the heat and 

pressure of the machine during operation.
• Use only well-constructed envelopes with sharp-and well-creased folds.
• Do not use stamped envelopes.
• Do not use envelopes with clasps, snaps, windows, coated lining, 

self-adhesive seals, or other synthetic materials.
• Do not use damaged or poorly made envelopes.
• Be sure the seam at both ends of the envelope extends all the way to 

the corner of the envelope.

1  Acceptable
2  Unacceptable

• Envelopes with a peel-off adhesive strip or with more than one flap that 
folds over to seal must use adhesives compatible with the machine’s 
fusing temperature about 170°C(338 °F) for 0.1 second. The extra flaps 
and strips might cause wrinkling, creasing, or jams, and may even 
damage the fuser.

• For the best print quality, position margins no closer than 15 mm (0.59 
inches) from the edges of the envelope.

• Avoid printing over the area where the envelope’s seams meet.
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Transparency
To avoid damaging the machine, use only transparencies designed for use 
in laser printers.

• Transparencies used in the machine must be able to withstand 
machine’s fusing temperature.

• Place them on a flat surface after removing them from the machine.
• Do not leave unused transparencies in the paper tray for long periods of 

time. Dust and dirt may accumulate on them, resulting in spotty printing.
• To avoid smudging caused by fingerprints, handle them carefully.
• To avoid fading, do not expose printed transparencies to prolonged 

sunlight.
• Ensure that transparencies are not wrinkled, curled, or have any torn 

edges.
• Do not use transparencies that separates from the backing sheet.
• To prevent transparencies from sticking to each other, do not let the 

printed sheets stack up as they are begin printed out. 
• Base type transparency (ex. Xerox 3R3117) results in better image and 

paper handling quality than paper backed (ex. Xerox 3R3028) or 
removable stripe (3R3108) ones.

Depending on the selection or storage conditions of the 
transparency, jam or image scratch might occur.

Labels
To avoid damaging the machine, use only labels designed for use in laser 
machines.

• When selecting labels, consider the following factors:
- Adhesives: The adhesive material should be stable at your 

machine’s fusing temperature. Check your machine’s specification to 
view the fusing temperature (about 170°C(338 °F).

- Arrangement: Only use labels with no exposed backing between 
them. Labels can peel off sheets that have spaces between the 
labels, causing serious jams.

- Curl: Prior to printing, labels must lie flat with no more than 13 mm
of curl in any direction.

- Condition: Do not use labels with wrinkles, bubbles, or other 
indications of separation.

• Make sure that there is no exposed adhesive material between labels. 

Exposed areas can cause labels to peel off during printing, which can 
cause paper jams. Exposed adhesive can also cause damage to 
machine components.

• Do not run a sheet of labels through the machine more than once. The 
adhesive backing is designed for only a single pass through the 
machine.

• Do not use labels that are separating from the backing sheet or are 
wrinkled, bubbled, or otherwise damaged.

Card stock/Custom-sized paper

• Do not print on media smaller than 76 mm (3 inches) wide or 127 mm (5 
inches) long.

• In the software application, set margins at least 6.4 mm (0.25 inches) 
away from the edges of the material.

Letterhead /Preprinted paper
SINGLE-SIDED DOUBLE-SIDED

Tray1
Optional tray

Face up Face down

Multi-purpose 
tray

Face down Face up

• Letterhead/ Preprinted paper must be printed with heat-resistant ink that 
will not melt, vaporize, or release hazardous emissions when subjected 
to the machine’s fusing temperature for 0.1 second. Check your 
machine’s specification to view the fusing temperature (about 
170°C(338 °F).

• Letterhead/ Preprinted paper ink must be non-flammable and should not 
adversely affect machine rollers.

• Forms and letterhead should be sealed in a moisture-proof wrapping to 
prevent changes during storage.

• Before you load letterhead/preprinted paper, verify that the ink on the 
paper is dry. During the fusing process, wet ink can come off preprinted 
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paper, reducing print quality.

Used paper
When loading used paper, printed side should be facing up with an uncurled 
edge at the front. If you experience problems with paper feed, turn the paper 
around. Note that print quality is not guaranteed.

• Used paper must be printed with heat-resistant ink that will not melt, 
vaporize, or release hazardous emissions when subjected to the 
machine’s fusing temperature for 0.1 second. Check your machine’s 
specification to view the fusing temperature (about 170°C(338 °F). 

• Used paper ink must be non-flammable and should not adversely affect 
machine rollers.

• Before you load used paper, verify that the ink on the paper is dry. 
During the fusing process, wet ink can come off used paper, reducing 
print quality.

Photo
• Make sure not to use the inkjet photo paper with this machine. It could 

cause damage to the machine. 

Glossy
Load one paper to the multi-purpose tray at a time, glossy side facing 
down. 

• Recommended media: Glossy paper (Letter) for this machine by HP 
Brochure Paper (Product: Q6611A) only.

• Recommended media: Glossy paper (A4) for this machine by HP
Superior Paper 160 glossy (Product: Q6616A).

SETTING THE PAPER TYPE AND SIZE
After loading paper in the paper tray, set the paper size and type using the 
control panel. For computer printing, select the paper size and type in the 
application program, select the Paper tab in the Printing Preferences (See 
"Opening printing preferences" on page 44).

The settings made from the machine driver override the settings on 
the control panel.

1. Press  on the control panel.
2. Press left/right arrow until Paper appears and press OK.
3. Press left/right arrow to select the paper tray you want press OK.
4. Press left/right arrow until Paper Size appears and press OK.
5. Press left/right arrow to select the paper size you want.
6. Press OK to save the selection.
7. Press left/right arrow until Paper Type appears and press OK.
8. Press left/right arrow to select the paper type you want.
9. Press OK to save the selection.

10. Press .
11. Press left/right arrow until Paper Source appears and press OK.
12. Press left/right arrow to select the paper tray you want.
13. press OK to save the selection.

14. Press  to return to ready mode.

If you want to use special-sized paper-such as a billing paper, select 
Edit... in the Paper tab in the Printing Preferences (See "Opening 
printing preferences" on page 44).

USING THE OUTPUT SUPPORT
The surface of the output tray may become hot if you print a large 
number of pages at once. Make sure that you do not touch the 
surface, and do not allow children near it.

The printed pages stack on the output support, and the output support will 
help the printed pages to align. Unfold the output support. 
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6.printing
This chapter explains common printing tasks.
This chapter includes:
• Introducing useful software programs
• Printer driver features
• Basic printing
• Opening printing preferences
• Using help
• Using special print features
• Postscript options (CLP-670 Series only)

• Changing the default print settings
• Setting your machine as a default machine
• Printing to a file (PRN)
• Macintosh printing
• Linux printing
• UNIX printing

• The procedures in this chapter are mainly based on Windows XP.
• Only CLP-670 Series supports PostScript driver. 

INTRODUCING USEFUL SOFTWARE 
PROGRAMS
Samsung AnyWeb Print
This tool helps you to screen-capture, preview, scrap and print the screen of 
Windows Internet Explorer more easily, than when you use the ordinary 
program. Click Start > All programs > Samsung Printers > Samsung 
AnyWeb Print > Download the latest version to link the website where 
the tool is available for the download. This tool is available only for Windows 
operating systems.

Samsung Easy Color Manager
This program helps users to adjust color as they like. Users can adjust the 
printout color as they see them on the monitor. The adjusted color can be 
stored on the printer driver and applied to printouts. Download this program 
from http://solution.samsungprinter.com/personal/colormanager.

PRINTER DRIVER FEATURES
Your printer drivers support the following standard features:
• Paper orientation, size, source, and media type selection
• Number of copies
In addition, you can use various special printing features. The following 
table shows a general overview of features supported by your printer 
drivers:

Some models or operating system may not support the certain 
feature(s) in the following table.

Printer driver 
Windows

FEATURE WINDOWS

Machine quality option

Poster printing

Multiple pages per sheet 

Fit to page printing

Reduce and enlarge printing

Different source for first page

Watermark

Overlay

Double-sided printing (duplex)

Toner save 

Darkness (CLP-620 Series only)
( : Supported, Blank: Not supported) 

Macintosh/Linux(CLP-620 Series only)

FEATURE MACINTOSH LINUX

Machine quality option

Multiple pages per sheet 
(2, 4)

Reduce and enlarge printing

Double-sided printing (duplex)
( : Supported, Blank: Not supported) 

FEATURE WINDOWS
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PostScript printer driver (CLP-670 Series only)
FEATURE WINDOWS LINUX MACINTOSH

Machine quality option

Poster printing

Multiple pages per sheet
(2, 4)

Fit to page printing

Reduce and enlarge 
printing

Different source for first 
page

Watermark

Double-sided printing 
(duplex)a

a.The machine with duplex feature prints both side of a paper.

Toner save 

( : Supported, Blank: Not supported) 

BASIC PRINTING
Your machine allows you to print from various Windows, Macintosh, or 
Linux applications. The exact steps for printing a document may vary 
depending on the application you use.

• Your Printing Preferences window that appears in this user’s 
guide may differ depending on the machine in use. However, the 
composition of the Printing Preferences window is similar. Check 
the operating system(s) that are compatible with your machine. 
Refer to the OS compatibility section of Printer Specifications (See 
"System requirements" on page 22).

• When you select an option in Printing Preferences, you may see 
a warning mark, , or . An exclamation mark ( ) means you 
can select that certain option but it is not recommended, and ( )
mark means you cannot select that option due to the machine’s 
setting or environment.

The following procedure describes the general steps required for printing 
from various Windows applications. 

Macintosh basic printing (See "Macintosh printing" on page 49).
Linux basic printing (See "Linux printing" on page 50).
UNIX basic printing (See "UNIX printing" on page 52).

The following Printing Preferences window is for Notepad in Windows XP. 
Your Printing Preferences window may differ, depending on your 
operating system or the application you are using. 
1. Open the document you want to print.
2. Select Print from the File menu. The Print window appears. 

3. Select your printer driver from the Select Printer list.

The basic print settings including the number of copies and print range 
are selected within the Print window. 

To take advantage of the printer features provided by your printer 
driver, click Properties or Preferences in the application’s Print
window to change the print setting (See "Opening printing 
preferences" on page 44).

4. To start the print job, click OK or Print in the Print window.
• The PostScript driver is recommended for best print image quality 

from PostScript-based applications such as Acrobat Reader®,
Adobe Illustrator®, Adobe Photoshop®, etc.

• If you are using Windows Internet Explorer, the Samsung AnyWeb 
Print too will save your time for screen-captured images or printing 
the image. Click Start > All programs > Samsung Printers > 
Samsung AnyWeb Print to link the website where the tool is 
available for the download.

Canceling a print job
If the print job is waiting in a print queue or print spooler, cancel the job as 
follows:
1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printer and Faxes.
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers.
• For Windows 7, select Control Panel > Hardware and Sound >

Devices and Printers.
• For Windows Server 2008 R2, select Control Panel > Hardware >

Devices and Printers.
3. For Windows 2000, XP, 2003 and Vista, double-click your machine.

For Windows 7 and Windows Server 2008 R2, right click your printer 
icon > context menus > See what’s printing.

If See what’s printing item has  mark, you can select other 
printer drivers connected with selected printer.

4. From the Document menu, select Cancel.
You can also access this window by simply double-clicking the 
machine icon ( ) in the Windows task bar. 
You can also cancel the current job by pressing  on the control 
panel.
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OPENING PRINTING PREFERENCES
You can preview the settings you selected on the upper right of the Printing
Preferences.
1. Open the document you want to print.
2. Select Print from the file menu. The Print window appears. 
3. Select the printer driver you want to use from the Select Printer.
4. Click Properties or Preferences.

The Printing Preferences window may differ depending on the 
driver you are using.

Using a favorite setting
The Presets option, which is visible on each preferences tab except for 
Samsung tab, allows you to save the current preferences settings for future 
use. 
To save a Presets item:
1. Change the settings as needed on each tab. 
2. Enter a name for the item in the Presets input box. 

3. Click Add. When you save Presets, all current driver settings are saved.
If you click Add, the Add button changes to Update button. Select more 
options and click Update, settings will be added to the Presets you made.
To use a saved setting, select it from the Presets drop down list. The 
machine is now set to print according to the setting you selected.
To delete saved setting, select it from the Presets drop down list and click 
Delete.
You can also restore the printer driver’s default settings by selecting Default
Preset from the Presets drop down list.

USING HELP
Click the question mark from the upper-right corner of the window and click 
on any option you want to know about. Then a pop up window appears with 
information about that option's feature which is provided from the driver. 

If you want to search information via a keyword, click the Samsung tab in 
the Printing Preferences window, and enter a keyword in the input line of 
the Help option. To get information about supplies, driver update or 
registration and so on, click appropriate buttons.

USING SPECIAL PRINT FEATURES
Special print features include:
• "Printing multiple pages on one sheet of paper" on page 44.
• "Printing posters" on page 44.
• "Printing booklets" on page 45.
• "Printing on both sides of paper" on page 45.
• "Change percentage of your document" on page 45.
• "Fitting your document to a selected paper size" on page 46.
• "Using watermarks" on page 46.
• "Using overlay (PCL driver only)" on page 46.
• "Adjusting color" on page 47.
• "Adjusting the sharpness and smoothness" on page 47.
• "Postscript options (CLP-670 Series only)" on page 48.

Printing multiple pages on one sheet of paper
You can select the number of pages to print on a single sheet of paper. To 
print more than one page per sheet, the pages will be reduced in size and 
arranged in the order you specify. You can print up to 16 pages on one 
sheet.
1. To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on page 44).
2. Click the Basic tab, select Multiple Pages Per Side in the Type

drop-down list.
3. Select the number of pages you want to print per sheet (2, 4, 6, 9, or 16) 

in the Pages per Side drop-down list.
4. Select the page order from the Page Order drop-down list, if necessary. 
5. Check Print Page Border to print a border around each page on the 

sheet.
6. Click the Paper tab, select the Size, Source, and Type.
7. Click OK or Print until you exit the Print window

Printing posters
This feature allows you to print a single-page document onto 4, 9, or 16 
sheets of paper, for the purpose of pasting the sheets together to form one 
poster-size document.
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1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 44).

2. Click the Basic tab, select Poster Printing in the Type drop-down list.
3. Select the page layout you want.

Specification of the page layout:
• Poster 2x2: Document will be enlarged and be divided into 4 

pages.
• Poster 3x3: Document will be enlarged and be divided into 9 

pages.
• Poster 4x4: Document will be enlarged and be divided into 16 

pages.
4. Select the Poster Overlap value. Specify Poster Overlap in millimeters 

or inches by selecting the radio button on the upper right of Basic tab to 
make it easier to paste the sheets together.

5. Click the Paper tab, select the Size, Source, and Type.
6. Click OK or Print until you exit the Print window
7. You can complete the poster by pasting the sheets together.

Printing booklets
This feature prints your document on both sides of a paper and arranges the 
pages so that the paper can be folded in half after printing to produce a 
booklet.

If you want to make a booklet, you need to print on Letter, Legal, A4, 
US Folio, or Oficio sized print media. 

8 9

1. To change the print settings from your software application, access the 
Printing Preferences (See "Opening printing preferences" on page 44).

2. Click the Basic tab, select Booklet Printing from the Type drop-down 
list.

3. Click the Paper tab, select the Size, Source, and Type.
The Booklet Printing option is not available for all paper sizes. In 
order to find out the available paper size for this feature, select the 
available paper size in the Size option on the Paper tab.
If you select an unavailable paper size, this option can be 
automatically canceled. Select only available paper. (paper without 

 or  mark).
4. Click OK or Print until you exit the Print window
5. After printing, fold and staple the pages.

Printing on both sides of paper
You can print on both sides of a paper; duplex. Before printing, decide how 
you want your document oriented. You can use this feature with Letter, 
Legal, A4, US Folio, or Oficio sized paper (See "Print media specifications" 
on page 89).

• Optional for CLP-670N.
• We recommend not to print on both sides of a special media, such 

as labels, envelopes  or thick paper to print on both sides of paper 
as the backing from the label sheet, or the flap from a envelope 
may cause a paper jam or damage the machine if printed on both 
sides.

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 44).

2. Click the Basic tab.
3. From the Double-Sided Printing section, select the binding option you 

want.   
• Printer Default: If you select this option, this feature is determined 

by the setting you’ve made on the control panel of the machine (PCL
driver only).

• None
• Long Edge: This option is the conventional layout used in 

bookbinding.

• Short Edge: This option is the conventional layout used in 
calendars.

• Reverse Double-Sided Printing: Check this option to reverse the 
print order when duplex printing.

4. Click the Paper tab, select the Size, Source, and Type.
5. Click OK or Print until you exit the Print window

If your machine does not have a duplex unit, you should complete the 
printing job manually. The machine prints every other page of the 
document first. After that, a message appears on your computer. 
Follow the on-screen instructions to complete the printing job.

Change percentage of your document
 You can change the size of a document to appear larger or smaller on the 
printed page by typing in a percentage you want.

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 44).

2. Click the Paper tab.
3. Enter the scaling rate in the Percentage input box.

You can also click the up/down arrows to select the scaling rate.
4. Select the Size, Source, and Type in Paper Options.
5. Click OK or Print until you exit the Print window
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Fitting your document to a selected paper size
This printer feature allows you to scale your print job to any selected paper 
size regardless of the document size. This can be useful when you want to 
check fine details on a small document. 

A

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 44).

2. Click the Paper tab.
3. Select the paper size you want from the Fit to Page.
4. Select the Size, Source, and Type in Paper Options.
5. Click OK or Print until you exit the Print window

Using watermarks
The watermark option allows you to print text over an existing document. 
For example, you use it when you want to have large gray letters reading 
“DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all 
pages of a document. 

There are several predefined watermarks that come with the machine. They 
can be modified, or you can add new ones to the list. 

Using an existing watermark
1. To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 44).

2. Click the Advanced tab, and select the desired watermark from the 
Watermark drop-down list. You will see the selected watermark in 
the preview image. 

3. Click OK or Print until you exit the print window

Creating a watermark
1. To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 44).

2. From the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3. Enter a text message in the Watermark Message box. You can 
enter up to 256 characters. The message appears in the preview 
window.
When the First Page Only box is checked, the watermark prints on 
the first page only.

4. Select watermark options. 
You can select the font name, style, size, and shade from the Font 
Attributes section, as well as set the angle of the watermark from 
the Message Angle section. 

5. Click Add to add a new watermark to the Current Watermarks list.

6. When you have finished editing, click OK or Print until you exit the 
Print window.

To stop printing the watermark, select None from the Watermark
drop-down list. 

Editing a watermark
1. To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 44).

2. Click the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3. Select the watermark you want to edit from the Current Watermarks
list and change the watermark message and options. 

4. Click Update to save the changes.
5. Click OK or Print until you exit the Print window. 

Deleting a watermark
1. To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 44).

2. Click the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3. Select the watermark you want to delete from the Current 
Watermarks list and click Delete.

4. Click OK or Print until you exit the Print window.

Using overlay (PCL driver only)
An overlay is text and/or images stored in the computer hard disk drive 
(HDD) as a special file format that can be printed on any document. 
Overlays are often used to take the place of letterhead paper. Rather than 
using preprinted letterhead, you can create an overlay containing exactly 
the same information that is currently on your letterhead. To print a letter 
with your company’s letterhead, you do not need to load preprinted 
letterhead paper in the machine just print the letterhead overlay on your 
document.

Creating a new page overlay
To use a page overlay, you must create a new page overlay containing 
your logo or image.
1. Create or open a document containing text or an image for use in a 

new page overlay. Position the items exactly as you wish them to 
appear when printed as an overlay.

2. To save the document as an overlay, access Printing Preferences
(See "Opening printing preferences" on page 44).

3. Click the Advanced tab, and select Edit from the Text drop-down 
list. Edit Overlay window appears.

4. In the Edit Overlay window, click Create.
5. In the Save As window, type a name of up to eight characters in the 

File name box. Select the destination path, if necessary. (The 
default is C:\Formover.)

6. Click Save. The name appears on the Overlay List.
7. Click OK or Print until you exit the Print window
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8. The file is not printed. Instead, it is stored on your computer hard disk 
drive.

The overlay document size must be the same as the document 
you print with the overlay. Do not create an overlay with a 
watermark.

Using a page overlay
After an overlay has been created, it is ready to be printed with your 
document. To print an overlay with a document:
1. Create or open the document you want to print.
2. To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 44).

3. Click the Advanced tab. 
4. Select the desired overlay from the Text drop-down list. 
5. If the overlay file you want does not appear in theText drop-down 

list, select Edit from the list and click Load. Select the overlay file 
you want to use. 
If you have stored the overlay file you want to use in an external 
source, you can also load the file when you access the Open
window. 
After you select the file, click Open. The file appears in the Overlay 
List box and is available for printing. Select the overlay from the 
Overlay List box. 

6. If necessary, check Confirm Page Overlay When Printing box. If 
this box is checked, a message window appears each time you 
submit a document for printing, asking you to confirm your wish to 
print an overlay on your document. 
If this box is not checked and an overlay has been selected, the 
overlay automatically prints with your document. 

7. Click OK or Print until you exit the Print window. 
The selected overlay prints on your document. 

The resolution of the overlay document must be the same as that 
of the document you will print with the overlay.

Deleting a page overlay
You can delete page overlays that you no longer use. 
1. In the Printing Preferences window, click the Advanced tab. 
2. Select Edit in the Overlay drop down list. 
3. Select the overlay you want to delete from the Overlay List box. 
4. Click Delete.
5. When a confirming message window appears, click Yes.
6. Click OK or Print until you exit the Print window.

Adjusting color
If you feel the color difference between the printout and monitor, you may 
change the color setting such as color contrast or color level.

If the option is grayed out or not shown, the option is not applicable 
with the printer language you are using.

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 44).

2. Click the Graphics tab.
• This options you can select may vary depending on your 

printer model. 
• Refer to the online help for each option’s information provided 

from the Printing Preferences.
• Color Mode: You can choose color options between Color or 

Grayscale. Setting to Color typically produces the best possible 
print quality for color document. If you want to print a color document 
in gray scale, select Grayscale.

BlackOptimization allows you to print in high quality black. If 
you use this option, it might take longer to print.

To adjust color manually, select Advanced. Simply slide the color 
balance slider in the Levels tab to adjust color, or select Matching
tab for driver provided color correction for general image processing.

• Font/Text: Select Normal or Maximum in Darken Text to print 
texts darker than on a normal document. Check All Text Black to 
print in solid black, regardless of the color it appears on the screen.
To set more advanced font options, select Advanced. Check one of 
the True Type Options or check Use Printer Fonts.

• Raster Compression: This option determines the compression 
level of images for transferring data from computer to a printer. If you 
set this option to Maximum, the printing speed will be high, but the 
printing quality will be low (PCL driver only).

• Graphic Controller
- Grayscale Enhancement: It allows user to preserve the details 

of nature photos, and improve contrast and readability among 
grayscaled colors, when printing color documents in grayscale 
(PCL driver only).

- Fine Edge: It allows user to emphasize edges of texts and fine 
lines for improving readability and align each color channel 
registration in color printing mode.

• Toner Save: Selecting this option extends the life of your toner 
cartridge and reduces your cost per page without a significant 
reduction in print quality.

3. Select Apply after completing the settings.

Adjusting the sharpness and smoothness
Screen options
This option affect the resolution and clarity of your color output. The 
three screen options are Normal, Enhanced and Detailed.
1. To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 44).

2. Click the Graphics tab then select Advanced in Color Mode.
3. Select the Matching tab.

• Printer default: Follows the set value of Screen mode from the 
printer (See "Graphic" on page 55).

• Normal: This mode will generate printouts with smooth tone 
over the entire page.

• Enhanced: This mode will generate printouts with sharp texts 
and smooth graphic/photo objects in the page.

• Detailed: This mode will generate printouts with sharp details 
over the entire page.

4. Select OK.
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POSTSCRIPT OPTIONS (CLP-670 SERIES ONLY)

Following options are only supported on the Post Script driver. 
Open the Printing Preferences (See "Opening printing preferences" on 
page 44) then click Graphic tab > PostScript Options.
• Output Option: This option allows you to select the output format for 

PostScript files. 
- Optimize for Speed: General format for PostScript files.
- Optimize for Portability: Creates a file that conforms to the Adobe 

Document Structuring Conventions(ADSC). This is a useful format to 
use when you want to create a PostScript file and print it on a 
different machine.

- Encapsulated PostScript(EPS): Creates a file as a image. This is 
a useful format to use if you want include the file as an image in 
another document that will be printed from a different program. 

- Archive Format: Creates a PostScript file you can use it later. 
• PostScript Language: This option allows you to choose the PostScript 

language level. 
• Send PostScript Error Handler: If this options is checked, the 

machine prints an error page when an error occurs during printing. 

CHANGING THE DEFAULT PRINT SETTINGS
Most Windows applications will override settings you specify in the 
printer driver. Change all print settings available in the software 
application first, and change any remaining settings using the printer 
driver. 

1. Click the Windows Start menu. 
2. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printer and Faxes.
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers.
• For Windows 7, select Control Panel > Hardware and Sound >

Devices and Printers.
• For Windows Server 2008 R2, select Control Panel > Hardware >

Devices and Printers.
3. Right-click your machine.

4. For Windows XP/2003/2008/Vista, press Printing Preferences.
For Windows 7 and Windows Server 2008 R2, from context menus, 
select the Printing preferences.

If Printing preferences item has  mark, you can select other 
printer drivers connected with selected printer.

5. Change the settings on each tab. 
6. Click OK.

If you want to change the settings for each print job, change it in 
Printing Preferences.

SETTING YOUR MACHINE AS A DEFAULT 
MACHINE
1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printer and Faxes.
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers.
• For Windows 7, select Control Panel > Hardware and Sound >

Devices and Printers.
• For Windows Server 2008 R2, select Control Panel > Hardware >

Devices and Printers.
3. Select your machine.
4. Right-click your machine and select Set as Default Printer.

For Windows 7 and Windows Server 2008 R2
If Set as default printer item has  mark, you can select other 
printer drivers connected with selected printer.

PRINTING TO A FILE (PRN)
You will sometimes need to save the print data as a file. 
To create a file:
1. Check the Print to file box at the Print window.

2. Click Print.
3. Type in the destination path and the file name, and then click OK.

For example c:\Temp\file name.
If you type in only the file name, the file is automatically saved in 
My Documents.
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MACINTOSH PRINTING
This section explains how to print using Macintosh. You need to set the print 
environment before printing. 
• USB connected (See "Macintosh" on page 24).
• Network connected (See "Macintosh" on page 30).

Printing a document
When you print with a Macintosh, you need to check the printer driver 
setting in each application you use. Follow the steps below to print from a 
Macintosh:
1. Open the document you want to print.
2. Open the File menu and click Page Setup (Document Setup in some 

applications).
3. Choose your paper size, orientation, scaling, other options, and make 

sure that your machine is selected. Click OK.

4. Open the File menu and click Print.
5. Choose the number of copies you want and indicate which pages you 

want to print. 
6. Click Print.

Changing printer settings
You can use advanced printing features provided by your machine.
Open an application and select Print from the File menu. The machine 
name, which appears in the printer properties window may differ depending 
on the machine in use. Except for the name, the composition of the printer 
properties pane is similar to the following.

• The setting options may differ depending on printers and 
Macintosh OS version.

• The following panes may differ, depending on your operating 
system or the application you are using.

The following pane is the first pane you will see when you open the printer 
properties pane. Select other advanced features from the drop down list. 

Layout
The Layout tab provides options to adjust how the document appears 
on the printed page. You can print multiple pages on one sheet of paper. 
Select Layout from the drop-down list under Orientation to access the 
following features.
• Pages per Sheet: This option determines how many pages to be 

printed on one page (See "Printing multiple pages on one sheet of 
paper" on page 50).

• Layout Direction: This option allows you to select the printing 
direction on a page similar to the examples on UI.

• Border: This option allows you to print a border around each page 
on the sheet.

• Two-Sided: This option allows you to print on both sides of a paper 
(See "Printing on both sides of paper" on page 50).

• Reverse Page Orientation: This option allows you to rotate paper 
180 degrees. 

Graphics
The Graphics tab provides options for selecting Quality. Select 
Graphics from the drop-down list under Orientation to access the 
graphic features.
• Quality: This option allows you to select the printing resolution. The 

higher the setting, the sharper the clarity of printed characters and 
graphics. The higher setting also may increase the time it takes to 
print a document.

• Color Mode: You can set the color options. Setting to Color
typically produces the best possible print quality for color documents. 
If you want to print a color document in grayscale, select Grayscale.

• BlackOptimization: allows you to print in high quality black. If you 
use this option, it might take longer to print.

• Advanced
- Page Color Setting: This option allows you to print some pages 

in color and other pages in mono within a document  For 
example, if you have chosen Grayscale in the Graphic tab, but 
you want to print pages 1~4 in color, then select Color in this 
option and type in 1-4. 

Job Accounting
This option allows you to print with the given permission. You can use 
this option if you have 512MB optional memory installed. 
• User permission:  If you check this option, only users with user 

permission can start a print job.
• Group permission: If you check this option, only groups with group 

permission can start a print job.

• If you want to encrypt job accounting password, refer to 
help  on the bottom left coner of the printer properties 
pane.

• Administrators can enable job accounting and configure 
permissions in SyncThru™Web Admin Service.

Job Setting
This option allows you to choose how to print the printing file by using 
the 512MB optional memory. 
• Print Mode: The default Print Mode is Normal, which is for printing 

without saving the printing file in the memory. 
- Normal: This mode prints without storing your document in the 

optional memory. 
- Proof: This mode is useful when you print more than one copy. 

You can print one copy first to check the quality, than print the 



Printing_ 50

rest of copies later. 
- Confidential: This mode is used for printing confidential 

documents. You need to enter a password to print. 
• User ID: This option is used when you need to find a saved file 

using the control panel. 
• Job Name: This option is used when you need to find a saved file 

using the control panel. 

Paper
Set Paper Type to correspond to the paper loaded in the tray from 
which you want to print. This will let you get the best quality printout. If 
you load a different type of print material, select the corresponding paper 
type.

Printer Features
• Reverse Duplex Printing: This option allows you to select general 

print order compared to duplex print order. If this option does not 
appear, your machine does not have this feature.

• Darken Text: Select this option to print texts darker than on a 
normal document.

• Fit to Page: This option allows you to scale your print job to any 
selected paper size regardless of the document size. This can be 
useful when you want to check fine details on a small document.

• RGB Color: This setting determines how colors are rendered. 
Standard is the most widely used setting which the color tone of this 
mode is the closest to that of standard monitor (sRGB Monitor). 
Vivid mode is appropriate for printing presentation data and charts. 
The color tone of Vivid mode produces more Vivid color images 
than that of Standard mode. Device mode is best used for printing 
fine lines, small characters and color drawings. The color tone of 
Device mode may be different from that of monitor, the pure toner 
colors are used for printing cyan, magenta and yellow colors.

• Screen: This option affect the resolution and clarity of your color 
output.

• Fine Edge: This option allows you to emphasize edges of texts and 
fine lines for improving readability and align each color channel 
registration in color printing mode.

Printing multiple pages on one sheet of paper
You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft pages.
1. Open an application, and select Print from the File menu.
2. Select Layout from the drop-down list under Orientation. In the Pages

per Sheet drop-down list, select the number of pages you want to print 
on one sheet of paper.

3. Select the other options you want to use.

4. Click Print, then machine prints the selected number of pages you want 
to print on one sheet of paper.

Printing on both sides of paper
You can print on both sides of the paper. Before printing in the duplex mode, 
decide on which edge you will be binding your finished document. The 
binding options are, as follows:
• Long-Edge Binding: This option is the conventional layout used in 

book binding.
• Short-Edge Binding: This option is the type often used with calendars.
1. From your Macintosh application, select Print from the File menu.
2. Select Layout from the drop-down list under Orientation.
3. Select a binding orientation from Two Sided Printing option.
4. Select the other options you want to use.
5. Click Print, then the machine prints the selected number of pages on a 

side of a paper.

If you print more than 2 copies, the last page of the first copy and the 
first page of the second copy might print on same sheet of paper. 
Avoid using this feature when you are printing more than 1 copy. 

LINUX PRINTING
Printing from applications
There are a lot of Linux applications that allow you to print using Common 
UNIX Printing System (CUPS). You can print on your machine from any 
such application.
1. Open an application, and select Print from the File menu.
2. Select Print directly using lpr.
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3. In the LPR GUI window, select the model name of your machine from 
the printer list and click Properties.

4. Change the print job properties using the following four tabs displayed at 
the top of the window.

• General: This option allows you to change the paper size, the paper 
type, and the orientation of the documents. It enables the duplex 
feature, adds start and end banners, and changes the number of 
pages per sheet.

• Text: This option allows you to specify the page margins and set the 
text options, such as spacing or columns.

• Graphics: This option allows you to set image options that are used 
when printing image files, such as color options, image size, or 
image position.

• Advanced: This option allows you to set the print resolution, paper 
source, and special print features.

If an option is grayed out, it means that the grayed out option is not 
supported.

5. Click Apply to apply the changes and close the Properties window.
6. Click OK in the LPR GUI window to start printing.

7. The Printing window appears, allowing you to monitor the status of your 
print job.
To abort the current job, click Cancel.

Printing files
You can print many different types of files on your machine using the 
standard CUPS way, directly from the command line interface. The CUPS 
lpr utility allows you to do that. But the drivers package replaces the 
standard lpr tool by a much more user-friendly LPR GUI program.
To print any document file:
1. Type lpr <file_name> from the Linux shell command line and press 

Enter. The LPR GUI window appears.
When you type only lpr and press Enter, the Select file(s) to print
window appears first. Just select any files you want to print and click 
Open.

2. In the LPR GUI window, select your machine from the list, and change 
the print job properties.

3. Click OK to start printing.

Configuring Printer Properties
Using the Printer Properties window provided by the Printers
configuration, you can change the various properties for your machine as 
a printer.
1. Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.
2. Select your machine on the available printers list and click Properties.
3. The Printer Properties window opens.

The following five tabs display at the top of the window:
• General: This option allows you to change the printer location and 

name. The name entered in this tab appears on the printer list in 
Printers configuration.

• Connection: This option allows you to view or select another port. If 
you change the machine port from USB to parallel or vice versa 
while in use, you must re-configure the machine port in this tab.

• Driver: This option allows you to view or select another machine 
driver. By clicking Options, you can set the default device options.

• Jobs: This option shows the list of print jobs. Click Cancel job to 
cancel the selected job and select the Show completed jobs check 
box to see previous jobs on the job list.

• Classes: This option shows the class that your machine is in. Click 
Add to Class to add your machine to a specific class or click 
Remove from Class to remove the machine from the selected 
class.

4. Click OK to apply the changes and close the Printer Properties
window.
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UNIX PRINTING 
Proceeding the print job
After installing the printer, choose any of the image, text, PS or HPGL files 
to print.
1. Execute “printui <file_name_to_print>” command.

For example, you are printing “document1”
printui document1
This will open the UNIX Printer Driver Print Job Manager in which the 
user can select various print options.

2. Select a printer which has been already added.
3. Select the printing options from the window such as Page Selection.
4. Select how many copies needed in Number of Copies.

To take advantage of the printer features provided by your printer 
driver, press Properties (See "Changing the printer settings" on 
page 52).

5. Press OK to start the print job.

Changing the printer settings
The UNIX Printer Driver Print Job Manager allows the user to select 
various print options in printer Properties.
The following hot keys may also be used: “H” for Help, “O” for OK and “A”
for Apply and “C” for Cancel.

General tab
• Paper Size: Set the paper size as A4, Letter or other paper sizes, 

according to your requirements.
• Paper Type: Choose the type of the paper. Options available in the 

list box are Printer Default, Plain, and Thick.
• Paper Source: Select the source of the page. By default, it is Auto

Selection.
• Orientation: Select the direction in which information is printed on a 

page.
• Duplex: Print on both sides of paper to save paper.
• Multiple pages: Print several pages on one side of paper.
• Page Border: Choose any of the border styles (e.g.: Single-line 

hairline, Double-line hairline)

Image tab
In this tab, you can change the brightness, resolution or an image 
position of your document.

Text tab
Set the character margin, line space or the columns of the actual print 
output.

HPGL/2 tab
• Use only black pen: To print all graphics in black.
• Fit plot to page: Fit the entire graphic into a single page.
• Pen Width: Change value to increase the thickness of pen lines. By 

default, it is 1000.

Margins tab
• Use Margins: Set the margins for the document. By default, 

margins are not enabled. The user can change the margin settings 
by changing the values in the respective fields. Set by default, these 
values depend on the page size selected.

• Unit: Change the units to points, inches or centimeters.
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Printer-Specific Settings tab
Select various options in the JCL and General frames to customize 
various settings. These options are specific to the printer and depend on 
the PPD file.
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7.machine status and advanced features
This chapter explains how to browse the current status of your machine, and the method of setting the advanced machine 
setup. Read this chapter carefully in order to use your machine's diverse features.
This chapter includes:
• Accessing the Menu
• Information
• Layout
• Paper
• Graphic

• System Setup
• Emulation
• Color
• Network
• Job management (CLP-670 Series only)

ACCESSING THE MENU
1. Press  on the control panel.
2. Press left/right arrow until the desired setting appears and press OK.
3. If the setting item has sub menus, repeat step 2.
4. Press left/right arrow to access the required value.
5. Press OK to save the selection.

6. If you want to move to the upper level menus, press .

7. Press  to return to ready mode.

INFORMATION

OPTION DESCRIPTION

Menu Map You can print the menu map which shows the 
layout and current settings on your machine.

Configuration You can print a report on the machine's overall 
configuration.

Supplies Info

Demo Page You can print the demo page whether your 
machine is printing properly or not.

PCL Font List You can print the PCL font list.

PS Font Lista

a.CLP-670 Series only.

You can print the PS font list.

Usage Pageb

b.You can only use this menu if you have installed the 512MB optional 
memory. (CLP-670 Series only)

The usage page contains the total number of 
pages printed.

Stored Jobb You can print jobs currently stored in the 512MB 
optional memory.

Account Reportb You can print a report on the number of 
printouts.

Counter Info.
b

You can print the counter information page.

LAYOUT

ITEM DESCRIPTION

Orientation This menu allows you to select the direction in 
which information is printed on a page.

Simplex Margin Set the margin of print materials for one-sided 
printing. You can increase or decrease the value 
in 0.1mm increments.
• Top Margin: Set the top margin, from 0.0 to 

250mm.
• Left Margin: Set the left margin, from 0.0 to 

164mm. 

Duplexa To print on both sides of paper, choose the 
binding edge.
• Long Edge: This item is the conventional 

layout used in bookbinding.

• Short Edge: This item is the conventional 
layout used in calendars.

Select Off to print on one side of the paper.
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PAPER

OPTION DESCRIPTION

Copies You can select the maximum amount of copies.

MP Tray [Tray<x>] • Paper Size: You can select the default 
paper size. 

• Paper Type: You can select the default 
paper type for the print media.

Paper Source You can select the tray to process the print job. 
If you select Auto, your machine supplies the 
paper from the multi-purpose tray first, than the 
tray 1, and tray 2 for the last. So if any tray is 
empty, then the machine try to search the paper 
from the next available tray.

GRAPHIC

OPTION DESCRIPTION

Resolution You can select the default resolution. If the 
resolution is high, the clarity of the printouts is 
sharper, but the print time may take longer.
• Draft: If the printer language is PCL and 

your print jobs are text, select this option for 
the best speed and printing quality. this 
option is available only with PCL driver. 

• Normal: If your print jobs are mostly text, 
select this option for the highest quality 
output.

• Best: Select this option when your job 
contains bit mapped images, such as 
scanned photos or certain business 
graphics, that will benefit from enhanced line 
screening.

Fine Edge It allows user to emphasize edges of texts and 
fine lines for improving readability and align 
each color channel registration in color printing 
mode.

Darken Text Select this option to print texts darker than on a 
normal document.

Screen This option affect the resolution and clarity of 
your color output.
• Normal: This mode will generate printouts 

with smooth tone over the entire page. 
• Enhanced: This mode will generate 

printouts with sharp texts and smooth 
graphic/photo objects in the page.

• Detailed: This mode will generate printouts 
with sharp details over the entire page.

SYSTEM SETUP

Duplex Margin In this menu, you can set the margins for 
double-sided printing. You can increase or 
decrease the value in 0.1mm increments.
• Top Margin: Set the top margin, from 0.0 to 

10mm.
• Left Margin: Set the left margin, from 0.0 to 

10mm.
• Short Binding: Set the left margin, from 0.0 

to 22mm. 
• Long Binding: Set the left margin, from 0.0 

to 22mm. 

a.This menu appears when duplex kit is installed.

ITEM DESCRIPTION

OPTION DESCRIPTION

Language Allows you to change the language that appears 
on the display (See "Changing the display 
language" on page 34).

Power Save Reduce energy consumption by setting power 
saving features (See "Using the power saving 
feature" on page 34).

Auto Continue This item determines whether or not the 
machine continues printing when it detects 
paper that is not matched to your paper setting.
• Off: If a paper mismatch occurs, the 

message remains on the display and the 
machine remains off-line until you insert the 
correct paper. 

• On: If the paper is mismatched, an error 
message appears. The machine goes 
off-line for 30 seconds then automatically 
clears the message and continues printing.
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EMULATION

OPTION DESCRIPTION

Emulation Type You can select the machine language. If the 
languages from the computer and the machine 
are different, the printing quality can not be 
confirmed. It is recommended to set this menu to 
Auto to switch the proper language.

Setup PCL
This menu sets the PCL emulation configuration. 
You can set the font type, symbol type, lines per 
page, and font size.
• Typeface: You can select the standard font 

to be used in PCL emulation. PCL1~PCL15's 
interval between letters is fixed, and 
PCL16~PCL86's interval is proportional to 
the font type and font size. You can adjust 
the font size of PCL1~PCL15 using the Pitch
item, and PCL16~PCL86 can do using Point
Size item. 

• Symbol: This item selects the symbol set to 
be used in PCL emulation. The symbol is the 
group of numbers, marks, and special signs 
being used when printing letters. Depending 
on the Typeface setting, available symbol 
sets vary.

• Point Size: When you select one between 
PCL16 and PCL86 from the Typeface menu, 
you can determine the font size by setting 
the height of the characters in the font.

• Courier: This item lets you select the 
version of Courier font to use. 

• Pitch: When you select one between PCL1 
and PCL15 from the Typeface menu, you 
can determine the font size by setting the 
number of characters that will print in one 
horizontal inch of type. The default value, 10 
is the best size.

• Lines: This item allows you to set vertical 
spacing from 5 to 128 lines for the default 
paper size. The default number of lines may 
differ according to the paper size and printing 
orientation.

PostScript (CLP-670 Series only)
This menu provides you with the Print PS Error
menu item. You can select whether or not your 
printer prints an error list when a PS error 
occurs. Select On to print PS 3 emulation errors. 
If an error occurs, the job stops processing, the 
error message prints, and the printer deletes all 
the jobs. If this menu is set to Off, the jobs are 
deleted without an indication of the error.

Altitude Adj. Print quality is affected by atmospheric 
pressure. The atmospheric pressure is 
determined by the height of the machine above 
sea level. This feature lets you adjust the 
altitude in a height district. (See "Altitude 
adjustment" on page 34).

Auto CR This option allows you to append the required 
carriage return to each line feed, which is useful 
to the UNIX user or DOS user.

Job Timeout You can set the amount of time a single print job 
is active before it must print. The machine 
handles incoming data as a single job, if it 
comes in within the specified time. When an 
error occurs while processing data from the 
computer and the data flow stops, the machine 
waits the specified amount of time and then 
cancels printing if data flow does not resume.

Maintenance This menu allows you to maintain consumables 
within the machine and check supplies' life. You 
can clean fuser components.

Clear Settings This menu item allows you to restore the 
printer's factory default settings.

OPTION DESCRIPTION
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COLOR

OPTION DESCRIPTION

Custom Color This menu allows you to adjust contrast, color by 
color.
• Default: Optimizes colors automatically. 
• Manual Adjust: Allows you to manually 

adjust the color contrast for each cartridge.
It is recommended to use the Default setting for 
best color quality.

Auto Color Reg You can adjust the position of color texts or 
graphics to match the position of the printed 
colors to those on your screen.

If you have moved the machine, it is 
strongly recommended to operate this 
menu manually.

Density Calib.a

a.CLP-670 Series only

You can manually calibrate the toner density of 
machine for the best possible color print quality.

Density Ctrla The machine automatically calibrates the toner 
density of machine for the best possible color 
print quality. 
If you select Off, the machine is calibrated by 
the factory default toner density.

NETWORK

OPTION DESCRIPTION

TCP/IP(IPv4) Select appropriate protocol and configure 
parameters to use the network environment.

There are lots of parameters to be set; 
therefore, if you are not sure, leave as is, or 
consult the network administrator.

TCP/IP(IPv6) Selects this option to use the network environment 
through IPv6. 

Ethernet Speed Configure the network transmission speed.

802.1x You can select the user authentication for network 
communication. For details, consult the network 
administrator.

Clear Settings Reverts the network settings to the default values.

Network Info. You can print the network configuration report.

JOB MANAGEMENT (CLP-670 SERIES ONLY)
You can only use this menu if you have installed the 512MB optional 
memory (See "Printing with the optional memory (CLP-670 Series only)" on 
page 85).
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8.management tools
This chapter introduces management tools provided to help you make full use of your machine. 
This chapter includes:
• Using SyncThru™ Web Service
• Using the Smart Panel program

• Using the Unified Driver Configurator

USING SYNCTHRU™ WEB SERVICE
If you have connected your machine to a network and set up TCP/IP 
network parameters correctly, you can manage the machine via SyncThru™ 
Web Service, an embedded web server. Use SyncThru™ Web Service to:
• View the machine’s device information and check its current status.
• Change TCP/IP parameters and set up other network parameters.
• Change printer preference.
• Set the email notifications advising of the machine’s status.
• Get support for using the machine.

To access SyncThru™ Web Service
1. Access a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.

Logging into SyncThru™ Web Service
Before configuring options in SyncThru™ Web Service, you need to 
log-in as an administrator. You can still use SyncThru™ Web Service 
without logging in but you won’t have access to Settings tab and 
Security tab. 
1. Click Login on the upper left of the SyncThru™ Web Service 

website.
A log-in page appears. 

2. Type in the ID and Password then click LOGIN .
If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
• ID: admin
• Password: sec00000

Changing the ID and password
For security reasons we recommand you to change the ID and 
password after logging in as a default ID and password. 
1. From the Security tab, click System Security > System 

Administrator.
2. Change the ID and password in the Web Interface Security.
3. Click Apply.

SyncThru™ Web Service overview
• Information tab: This tab gives you general information about your 

machine. You can check things, such as the machine’s status, supplies 
status, count information, network information and so on. You can also 
print reports such as configuration page and so on. 

• Settings tab: This tab allows you to set configurations provided by your 
machine and network.

• Security tab: This tab allows you to set system and network security 
information.

• Maintenance tab: This tab allows you to maintain your machine by 
upgrading firmware and setting contact information for sending email. 
You can also connect to Samsung website or download drivers by 
selecting the Link menu.

E-mail notification setup
You can receive emails about your machine’s status by setting this option. 
By setting information such as IP address, host name, e-mail address and 
SMTP server information, the machine status (toner cartridge shortage or 
machine error) will be sent to a certain person's e-mail automatically. This 
option may be used more frequently by a machine administrator. 
1. Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.
3. From the Settings tab, select Machine Settings > E-mail Notification.

If you haven’t configured outgoing server environment, go to 
Settings > Network Settings > Outgoing Mail Server(SMTP) to 
configure network environment before setting e-mail notification. 

4. Click Add button to add e-mail notification user. 
Set the recipient name and e-mail address(es) with notification items 
you want to receive an alert for.

5. Click Apply.
If the firewall is activated, the e-mail may not be sent successfully. In 
that case, contact the a network administrator.

Setting the system administrator information
Set the the system administrator information. This setting is necessary for 
using the e-mail notification option.
1. Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.
3. From the Security tab, select System Security > System 

Administrator
4. Enter the name of the administrator, phone number, location and E-mail 

address. 
5. Click Apply.
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USING THE SMART PANEL PROGRAM
Smart Panel is a program that monitors and informs you of the machine 
status, and allows you to customize the machine’s settings. For Winodws 
and Macintosh, Smart Panel is installed automatically when you install the 
machine software. For Linux, you can download Smart Panel from 
Samsung website and install (See "Installing the SmartPanel" on page 25).

To use this program, you need the following:
• Windows. Check for windows operating system(s) compatible with 

your machine (See "System requirements" on page 22).
• Mac OS X 10.3 or higher.
• Linux. Check for Linux systems that are compatible with your 

machine (See "System requirements" on page 22).
• Internet Explorer version 5.0 or higher for flash animation in HTML 

Help.
If you need to know the exact model name of your machine, you can 
check the supplied software CD.

Understanding Smart Panel
If an error occurs while printing, you can check the error from the Smart 
Panel.
You can also launch Smart Panel manually. Double-click the Smart Panel
icon on the Windows task bar (in Windows), or Notification Area (in Linux). 
You can also click it on the status bar (in Mac OS X).

Windows Double-click this icon in Windows.

Macintosh Click this icon in Mac OS X.

Linux Click this icon in Linux.

Or, if you are a Windows user, you can launch it from the Start menu, select 
All Programs > Samsung Printers > your printer driver name > Smart 
Panel.

• If you have already installed more than one Samsung machine, 
first select the correct machine model you want in order to access 
the corresponding Smart Panel.
Right-click (in Windows or Linux) or click (in Mac OS X) the Smart 
Panel icon and select your machine.

• The Smart Panel window and its contents shown in this user’s 
guide may differ depending on the machine or operating system in 
use.

The Smart Panel program displays the current status of the machine, the 
level of toner remaining in the toner cartridge(s), and various other types of 
information. You can also change settings.

1

Toner Level View the level of toner remaining in the toner 
cartridge(s). The machine and the number of toner 
cartridge(s) shown in the above window may differ 
depending on the machine in use. Some machines 
do not have this feature.

2 Buy Now Order replacement toner cartridge(s) online.

3

User’s Guide View User’s Guide.
This button changes to Troubleshooting 
Guide when error occurs. You can directly 
open troubleshooting section in the user’s 
guide. 

4

Printer
Setting

Configure various machine settings in the Printer 
Settings Utility window. Some machines do not 
have this feature.

If you connect your machine to a network, 
the SyncThru™ Web Service window 
appears instead of the Printer Settings Utility 
window.

5

Driver Setting Set all of the machine options you need in the 
Printing Preferences window. This feature is 
available only for Windows (See "Opening printing 
preferences" on page 44).

Opening the Troubleshooting Guide
Find solutions for problems by using the Troubleshooting Guide.
Right-click (in Windows or Linux) or click (in Mac OS X) the Smart Panel
icon and select Troubleshooting Guide.

Changing the Smart Panel Program Settings
Right-click (in Windows or Linux) or click (in Mac OS X) the Smart Panel
icon and select Options. Select the settings you want in the Options
window.

USING THE UNIFIED DRIVER CONFIGURATOR
Unified Driver Configurator is a tool primarily intended for configuring 
machine devices. You need to install Unified Linux Driver to use Unified 
Driver Configurator (See "Installing the Unified Linux Driver" on page 25).
After the driver is installed on your Linux system, the Unified Driver 
Configurator icon will automatically be created on your desktop

Opening the Unified Driver Configurator
1. Double-click the Unified Driver Configurator on the desktop.

You can also click the startup menu icon and select Samsung Unified 
Driver > Unified Driver Configurator.

2. Click each button on the left to switch to the corresponding configuration 
window. 



1 Printers
configuration 

2 Ports
configuration 
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 To use the on screen help, click Help.

3. After changing the configurations, click Exit to close the Unified Driver 
Configurator.

Printers configuration
Printers configuration has the two tabs: Printers and Classes.

Printers Tab
View the current system’s printer configuration by clicking on the 
machine icon button on the left side of the Unified Driver Configurator 
window.

1 Switches to Printers configuration.

2 Shows all of the installed machine.

3 Shows the status, model name and URI of your machine.

The printer control buttons are, as follows:
• Refresh: Renews the available machines list.

• Add Printer: Allows you to add a new machines.
• Remove Printer: Removes the selected machine.
• Set as Default: Sets the current selected machine as a default 

machine.
• Stop/Start: Stops/starts the machine.
• Test: Allows you to print a test page to ensure the machine is 

working properly.
• Properties: Allows you to view and change the printer properties.

Classes Tab
The Classes tab shows a list of available machine classes.

1 Shows all of the machine classes.

2
Shows the status of the class and the number of machines in the 
class.

• Refresh: Renews the classes list.
• Add Class: Allows you to add a new machine class.
• Remove Class: Removes the selected machine class.
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Ports configuration
In this window, you can view the list of available ports, check the status of 
each port and release a port that is stalled in a busy state when its owner 
has terminated the job for any reason.

1 Switches to Ports configuration.

2 Shows all of the available ports.

3 Shows the port type, device connected to the port, and status.

• Refresh: Renews the available ports list.
• Release port: Releases the selected port.
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9.maintenance
This chapter provides information for maintaining your machine and the toner cartridge.
This chapter includes:
• Printing a machine report
• Monitoring the supplies life
• Cleaning a fuser belt
• Using Toner Low Alert

• Cleaning the machine
• Storing the toner cartridge
• Tips for moving & storing your machine

PRINTING A MACHINE REPORT
You can print the machine's information.

1. Press  on the control panel.
2. Press left/right arrow until Information appears, and press OK.
3. Press left/right arrow until Configuration appears and press OK.
4. The display shows Print?, then press OK to print the configuration 

report.
You can use SyncThru™ Web Service as well to print the machine's 
configuration or browse the status of the machine. Open the web 
browser on your networked computer and type the machine's IP 
address. When SyncThru™ Web Service opens, click Information > 
Print Information.

MONITORING THE SUPPLIES LIFE
To view the supply life indicators, follow the steps below:

1. Press  on the control panel.
2. Press left/right arrow until System Setup appears, and press OK.
3. Press left/right arrow until Maintenance appears, and press OK.
4. Press left/right arrow until Supplies Info. appears, and press OK.
5. The display shows option as you press the left/right arrow button.

• Printed Pages: Displays the total number of pages printed.
6. When you select the option, press OK to browse the life.

CLEANING A FUSER BELT
If you are experiencing blurred, faded, or smeared printouts, you can clear 
the problem by printing a cleaning sheet, provided by your printer.
You can Print:

1. Press  on the control panel.
2. Press left/right arrow until System Setup appears, and press OK.
3. Press left/right arrow until Maintenance appears, and press OK.
4. Press left/right arrow until Clean Fuser appears, and press OK.

Your machine automatically picks up a sheet of paper from the tray and 
prints out a cleaning sheet with dust or toner particles on it. 

USING TONER LOW ALERT
If the amount of toner in the cartridge is low, a message informing user to 
change the toner cartridge appears. You can set the option for this message 
to appear or not. 

1. Press  on the control panel.
2. Press left/right arrow until System Setup appears, and press OK.
3. Press left/right arrow until Maintenance appears, and press OK.
4. Press left/right arrow until Toner Low Alert appears, and press OK.

CLEANING THE MACHINE
If printing quality problems occur or if you use your machine in a dusty 
environment, you need to clean your machine regularly to keep the best 
printing condition and use your machine longer.

• Cleaning the cabinet of the machine with cleaning materials 
containing large amounts of alcohol, solvent, or other strong 
substances can discolor or disfigure the cabinet. 

• If your machine or the surrounding area is contaminated with 
toner, we recommend you use a soft lint free cloth or tissue 
dampened with water to clean it. If you use a vacuum cleaner, 
toner blows in the air and might be harmful to you.

Cleaning the outside
Clean the machine cabinet with a soft lint free cloth. Dampen the cloth 
slightly with water, but be careful not to let any water drip onto or into the 
machine.

Cleaning the inside
During the printing process, paper, toner, and dust particles can accumulate 
inside the machine. This buildup can cause print quality problems, such as 
toner specks or smearing. Cleaning the inside of the machine clears and 
reduces these problems.
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1. Turn the machine off and unplug the power cord. Wait for the machine to 
cool down.

2. Using the handle, completely open the front cover.

• Do not touch the green surface, the OPC drum or the front of 
the toner cartridge, with your hands or any other material. Use 
the handle on each cartridge in order to avoid touching this 
area. 

• Be careful not to scratch the surface of the paper transfer belt.
• If you leave the front cover open for more than a few minutes, 

the OPC drum can be exposed to light. This will cause damage 
to the OPC drum. Cover the OPC drum of the toner cartridge 
with the clean paper to avoid damaging it from the light while 
you clean the inside.

3. Press the green release handle to release the paper transfer belt. 
Holding the handle on the paper transfer belt, lift it out of the machine.

4. Grasp the handles on the toner cartridge and pull to remove all the 
cartridge from the machine one at a time.

If you open the front cover, be careful not to touch the underneath 
the control panel (the lower part of the fuser unit). The temperature 
of the fuser unit might be high and could damage your skin. 

When you open the front cover and work inside the machine, it is 
highly recommend that you remove the paper transfer belt first. 
Because the work you do could contaminate the paper transfer 
belt.

5. With a dry, lint-free cloth, wipe away any dust and spilled toner from the 
toner cartridge area.

If toner gets on your clothing, wipe it off with a dry cloth and wash it 
in cold water. Hot water sets toner into fabric. 
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6. Locate the long strip of glass (LSU) inside the machine and gently swab 
the glass to see if dirt turns the white cotton black.

7. Slide the toner cartridge back into the machine. 
8. Holding the handle on the paper transfer belt, align it with the slots on 

the inside of the front cover.

9. Lower the paper transfer belt until it is parallel with the front cover and 
firmly seated.

10. Close the front cover. Ensure that the cover is securely closed. 
If the front cover is not completely closed, the machine will not 
operate. 

11. Plug in the power cord and turn the machine on.

STORING THE TONER CARTRIDGE
Toner cartridges contain components that are sensitive to light, 
temperature, and humidity. Samsung suggests users follow the 
recommendations to ensure the optimum performance, highest quality, and 
longest life from your new Samsung toner cartridge.
Store this cartridge in the same environment as the printer it will be used in; 
this should be in controlled office temperature and humidity conditions. The 
toner cartridge should remain in its original, unopened package until 
installation – If original packaging is not available, cover the top opening of 
the cartridge with paper and store in a dark cabinet.
Opening the cartridge package prior to use dramatically shortens its useful 
shelf and operating life. Do not store on the floor. If the toner cartridge is 
removed from the printer, always store the cartridge:
• Inside the protective bag from the original package. 
• Store lying flat (not standing on end) with the same side facing up as if 

they were installed in the machine.
• Do not store consumables in;

- Temperature greater than 40°C (104°F).
- Humidity range less than 20% nor greater than 80%.
- An environment with extreme changes in humidity or temperature.
- Direct sunlight or room light.
- Dusty places.
- A car for a long period of time.
- An environment where corrosive gases are present.
- An environment with salty air.

Handling instructions
• Do not touch the surface of the photosensitive drum in the cartridge.
• Do not expose the cartridge to unnecessary vibrations or shock.
• Never manually rotate the drum, especially in the reverse direction; this 

can cause internal damage and toner spillage.

Use of non-Samsung and refilled toner cartridge
Samsung does not recommend or approve the use of non-Samsung brand 
toner cartridges in your printer including generic, store brand, refilled, or 
remanufactured toner cartridges.

Samsung’s printer warranty does not cover damage to the machine 
caused by the use of a refilled, remanufactured, or non-Samsung 
brand toner cartridge.

Estimated cartridge life
Estimated cartridge life (the life of the toner cartridge yield) depends on the 
amount of toner that print jobs require. The actual print-out number may 
vary depending on the print density of the pages you print on, operating 
environment, printing interval, media type, and/or media size. For example, 
if you print a lot of graphics, the consumption of the toner is high and you 
may need to change the cartridge more often.

TIPS FOR MOVING & STORING YOUR MACHINE
• When moving the machine, do not tilt or turn it upside down. Otherwise, 

the inside of the machine may be contaminated by toner, which can 
cause damage to the machine or bad print quality.

• When moving the machine, make sure at least two people are holding 
the machine securely. 



Troubleshooting_ 65

10.troubleshooting
This chapter gives helpful information for what to do if you encounter an error.
This chapter includes:
• Redistributing toner
• Tips for avoiding paper jams
• Clearing paper jams

• Understanding display messages
• Solving other problems

REDISTRIBUTING TONER
When a toner is low, faded or light areas may appear. It is possible that 
colored images may be printed with incorrect colors due to flawed mixing of 
toner colors when the toner level of the colored toner cartridge is low. You 
can temporarily improve print quality by redistributing the toner.
• The toner-related message saying that the toner is low may appear on 

the display. 
• The Smart Panel program window appears on the computer telling you 

which color cartridge is low on toner. 
1. Using the handle, completely open the front cover.

• Do not touch the green surface, the OPC drum or the front of 
the toner cartridge, with your hands or any other material. Use 
the handle on each cartridge in order to avoid touching this 
area. 

• Be careful not to scratch the surface of the paper transfer belt.
• If you leave the front cover open for more than a few minutes, 

the OPC drum can be exposed to light. This will cause damage 
to the OPC drum. Close the front cover when the installation 
needs to be halted for any reason.

2. Press the green release handle to release the paper transfer belt. 
Holding the handle on the paper transfer belt, lift it out of the machine.

3. Grasp the handles on the toner cartridge and pull the cartridge out.

If you open the front cover, be careful not to touch the underneath 
the control panel (the lower part of the fuser unit). The temperature 


